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Notice

While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves the
right to make changes and corrections to the information in this
document without the obligation to notify any person or organization of
such changes.

Documentation disclaimer

“Documentation” means information published by Avaya in varying
mediums which may include product information, operating instructions
and performance specifications that Avaya may generally make
available to users of its products and Hosted Services. Documentation
does not include marketing materials. Avaya shall not be responsible
for any modifications, additions, or deletions to the original published
version of documentation unless such modifications, additions, or
deletions were performed by Avaya. End User agrees to indemnify and
hold harmless Avaya, Avaya's agents, servants and employees against
all claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not necessarily
endorse the products, services, or information described or offered
within them. Avaya does not guarantee that these links will work all the
time and has no control over the availability of the linked pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: http://support.avaya.com or such successor site as
designated by Avaya. Please note that if you acquired the product(s)
from an authorized Avaya Channel Partner outside of the United States
and Canada, the warranty is provided to you by said Avaya Channel
Partner and not by Avaya.

Licenses

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO OR
SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, ARE
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC.,
ANY AVAYA AFFILIATE, OR AN AVAYA CHANNEL PARTNER (AS
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH AVAYA
OR AN AVAYA CHANNEL PARTNER. UNLESS OTHERWISE
AGREED TO BY AVAYA IN WRITING, AVAYA DOES NOT EXTEND
THIS LICENSE IF THE SOFTWARE WAS OBTAINED FROM
ANYONE OTHER THAN AVAYA, AN AVAYA AFFILIATE OR AN
AVAYA CHANNEL PARTNER; AVAYA RESERVES THE RIGHT TO
TAKE LEGAL ACTION AGAINST YOU AND ANYONE ELSE USING
OR SELLING THE SOFTWARE WITHOUT A LICENSE. BY
INSTALLING, DOWNLOADING OR USING THE SOFTWARE, OR
AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF
YOURSELF AND THE ENTITY FOR WHOM YOU ARE INSTALLING,
DOWNLOADING OR USING THE SOFTWARE (HEREINAFTER
REFERRED TO INTERCHANGEABLY AS “YOU” AND “END USER”),
AGREE TO THESE TERMS AND CONDITIONS AND CREATE A
BINDING CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants you a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License. The applicable
number of licenses and units of capacity for which the license is granted
will be one (1), unless a different number of licenses or units of capacity
is specified in the documentation or other materials available to you.
“Software” means Avaya’s computer programs in object code, provided
by Avaya or an Avaya Channel Partner, whether as stand-alone
products, pre-installed , or remotely accessed on hardware products,
and any upgrades, updates, bug fixes, or modified versions thereto.
“Designated Processor” means a single stand-alone computing device.
“Server” means a Designated Processor that hosts a software
application to be accessed by multiple users. “Instance” means a single
copy of the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.

License types

Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only on a number of
Designated Processors up to the number indicated in the order. Avaya
may require the Designated Processor(s) to be identified in the order
by type, serial number, feature key, Instance, location or other specific
designation, or to be provided by End User to Avaya through electronic
means established by Avaya specifically for this purpose.

Concurrent User License (CU). End User may install and use the
Software on multiple Designated Processors or one or more Servers,
so long as only the licensed number of Units are accessing and using
the Software at any given time. A “Unit” means the unit on which Avaya,
at its sole discretion, bases the pricing of its licenses and can be,
without limitation, an agent, port or user, an e-mail or voice mail account
in the name of a person or corporate function (e.g., webmaster or
helpdesk), or a directory entry in the administrative database utilized
by the Software that permits one user to interface with the Software.
Units may be linked to a specific, identified Server or an Instance of the
Software.

Database License (DL). End User may install and use each copy or an
Instance of the Software on one Server or on multiple Servers provided
that each of the Servers on which the Software is installed
communicates with no more than an Instance of the same database.

CPU License (CP). End User may install and use each copy or Instance
of the Software on a number of Servers up to the number indicated in
the order provided that the performance capacity of the Server(s) does
not exceed the performance capacity specified for the Software. End
User may not re-install or operate the Software on Server(s) with a
larger performance capacity without Avaya’s prior consent and
payment of an upgrade fee.

Named User License (NU). You may: (i) install and use the Software
on a single Designated Processor or Server per authorized Named
User (defined below); or (ii) install and use the Software on a Server so
long as only authorized Named Users access and use the Software.
“Named User”, means a user or device that has been expressly
authorized by Avaya to access and use the Software. At Avaya’s sole
discretion, a “Named User” may be, without limitation, designated by
name, corporate function (e.g., webmaster or helpdesk), an e-mail or
voice mail account in the name of a person or corporate function, or a
directory entry in the administrative database utilized by the Software
that permits one user to interface with the Software.

Shrinkwrap License (SR). You may install and use the Software in
accordance with the terms and conditions of the applicable license
agreements, such as “shrinkwrap” or “clickthrough” license
accompanying or applicable to the Software (“Shrinkwrap License”).

Heritage Nortel Software

“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software currently
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available for license from Avaya is the software contained within the list
of Heritage Nortel Products located at http://support.avaya.com/
LicenseInfo/ under the link “Heritage Nortel Products”, or such
successor site as designated by Avaya. For Heritage Nortel Software,
Avaya grants Customer a license to use Heritage Nortel Software
provided hereunder solely to the extent of the authorized activation or
authorized usage level, solely for the purpose specified in the
Documentation, and solely as embedded in, for execution on, or (in the
event the applicable Documentation permits installation on non-Avaya
equipment) for communication with Avaya equipment. Charges for
Heritage Nortel Software may be based on extent of activation or use
authorized as specified in an order or invoice.

Copyright

Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the Product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way any
content, in whole or in part, including any code and software unless
expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Third Party Components

“Third Party Components” mean certain software programs or portions
thereof included in the Software or Hosted Service may contain
software (including open source software) distributed under third party
agreements (“Third Party Components”), which contain terms
regarding the rights to use certain portions of the Software (“Third Party
Terms”). As required, information regarding distributed Linux OS
source code (for those Products that have distributed Linux OS source
code) and identifying the copyright holders of the Third Party
Components and the Third Party Terms that apply is available in the
Documentation or on Avaya’s website at: http://support.avaya.com/
Copyright or such successor site as designated by Avaya. You agree
to the Third Party Terms for any such Third Party Components

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can result
in substantial additional charges for your telecommunications services.

Avaya Toll Fraud intervention

If you suspect that you are being victimized by Toll Fraud and you need
technical assistance or support, call Technical Service Center Toll
Fraud Intervention Hotline at +1-800-643-2353 for the United States
and Canada. For additional support telephone numbers, see the Avaya
Support website: http://support.avaya.com or such successor site as
designated by Avaya. Suspected security vulnerabilities with Avaya
products should be reported to Avaya by sending mail to:
securityalerts@avaya.com.

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and Product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, or other third parties. Users are not permitted to use such
Marks without prior written consent from Avaya or such third party
which may own the Mark. Nothing contained in this site, the
Documentation, Hosted Service(s) and Product(s) should be construed
as granting, by implication, estoppel, or otherwise, any license or right

in and to the Marks without the express written permission of Avaya or
the applicable third party.

Avaya is a registered trademark of Avaya Inc.

All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.

Downloading Documentation

For the most current versions of Documentation, see the Avaya
Support website: http://support.avaya.com, or such successor site as
designated by Avaya.

Contact Avaya Support

See the Avaya Support website: http://support.avaya.com for Product
or Hosted Service notices and articles, or to report a problem with your
Avaya Product or Hosted Service. For a list of support telephone
numbers and contact addresses, go to the Avaya Support website: 
http://support.avaya.com (or such successor site as designated by
Avaya), scroll to the bottom of the page, and select Contact Avaya
Support.
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Chapter 1: Introduction

Intelligent Customer Routing (ICR) helps businesses to capitalize on the next competitive differentiator in
the Customer Experience. ICR provides enhanced customer service experience by identifying and
determining caller intent through simple, intelligent, customer conversations using speech and self
service. ICR provides the opportunity for customers to serve themselves and, when needed, determines
the most optimal route to provide live assistance to that end consumer leveraging resources enterprise
wide. Avaya has unified self and assisted service into a single smart call routing solution that dynamically
manages available media and IT resources while enabling a personalized high-value service from start
to finish.

Following diagram gives an overall picture of how you can implement ICR in your system.

 

 

With ICR, Avaya begins the transition to the next generation contact centers by leveraging Avaya’s next
generation enterprise communication architecture, Avaya Aura®. This user centric architecture focuses
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on any-media, any-application, and any-device from the ground up. Earlier contact center solutions have
used computer telephony integration (CTI) to collaborate number of different applications and protocols
into complex solutions. These solutions were difficult to deploy, operate, and support. ICR removes the
complexity, leveraging Session Initiation Protocol (SIP) for standards based integration and delivery of
information or contact to any resource within or external to the enterprise.

As soon as a call arrives, a customer can be greeted intelligently based on business insights. While
customers are waiting for live agents, Intelligent Customer Routing can present personalized up-sell or
cross-sell messages, call-back options, and even opt-in services to pro-actively notify customers of
transaction status before the call even occupies resources on an ACD.

For example:

• Determine if this customer has talked to anyone in the past regarding their need and if the customers
would like to be connected to the same resource.

• Gather more information about a caller based on a request; location of home purchase for which the
caller need a loan, existing loan number, and an order number.

• Offer an opportunity only to premium customers (and tell the customers that the opportunity is specific
for them as highly valued customers) to pre-register for the service when the service becomes
available.

• Ask customers about their experience with a previous purchase (could be a tool, a cell phone, a
toaster, or a travel experience). Based on that feedback – react.

• Reference customers to a local help desk that will offer configuration and assistance free of charge.
Send them an e-mail with a quick tips guide.

Benefits
Following are the benefits of using Avaya Intelligent Customer Routing:

• Manage calls faster and more intelligently, to enhance customer service experience and
increase customer loyalty.

• Conduct productive or business useful activities while the caller is in queue. Calls are
initially delivered to a portal and routed to an ACD only when agent assistance is required.
Self-service no longer consumes ACD resources or requires Interactive Voice Response
(IVR) agent licenses.

• Keep your existing agent endpoints, call-routing systems and other resources, thereby
preserving existing investments.

• Lower ownership costs by saving money on deployment and maintenance due to
streamlined management and improved call distribution.

• Scale beyond the capacity limitations of a single Automatic Call Distribution (ACD). Avaya
ICR is applicable to both single site and multi site ACD customers.

Introduction
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• Disaster Management: When an ACD is down, the calls queued to that ACD are not lost,
ICR re-queues the call to other available ACDs without the knowledge of the customer.

• Reduce the complexity of administering a solution. This includes Best Service Routing
(BSR) as well as the self service and Wait Treatment Applications (WTA). You can
perform BSR administration from a single console. This helps in reducing code complex
vectors.

• Information transport is through Session Initiation Protocol (SIP). Leveraging the power
of SIP, Avaya ICR lets customers connect with agents and subject experts anywhere in
the enterprise.

• Application scripting is based on Voice XML (VXML) and Call Control XML (CCXML)
standards and is consolidated onto a single, industry-standard, Eclipse-based application
development environment called the Avaya Aura® Orchestration Designer.

Features
Intelligent Customer Routing or ICR provides features to efficiently handle customer calls for
an organization. In ICR, calls are either completely served through self service applications or
intelligently routed to a relevant call center across applicable geographic locations based on
the best available source of real-time data.

You can use the following features to provide the necessary self service and routing:

Self Service First using Avaya Aura® Experience Portal
Self Service first is provided through Avaya Aura® Experience Portal as the first point of access
to an organization. Calls connect to a Avaya Aura® Experience Portal application prior to
connecting an Automatic Call Distribution (ACD).

Intelligent Routing
In a contact center, agents or experts are the most valuable and most expensive resources.
Therefore organizations must effectively utilize agents or experts.

Using Avaya Aura® Experience Portal as the call control point, the Intelligent Customer Routing
solution selects among a group of contact center locations and routes the caller to the most
optimal contact center and the best-suited agent at that time. With the Best Service Routing
(BSR) infrastructure ICR locates the best location for a call based on the shortest queue and
skill availability.

ICR also has the ability to self service customers or place a virtual call, parked it on the ACD,
and provide an enhanced wait treatment.

Enhanced or Advanced Wait Treatment
In ICR, while a call is queued to Communication Manager, an advanced wait treatment
application is played for caller. This enables self service or predictive offers to be provided

Features
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while a call is in queue awaiting an agent to become available. This queue time can be used
for activities such as:

• Information Gathering – gathers additional information necessary to provide to an agent
upon call delivery.

• Issue resolution – provides information to, or gathers information from a customer in the
interest of resolving an issue (zip code needed for order shipment).

• Up sell – offer customers opportunities based on previous activities or purchases or play
special messages regarding new promotions as applicable to a customers profile.

• Opt-in Services – provide customer ability to sign up for new value added services such
as SMS messages with bill due dates and amounts, and shipment information.

• Call back assist – provide call back options for a customer based on estimated (or
predicted) queue wait times.

• The wait treatments can be configured to play based on the length of the wait time
When an agent becomes available, the caller is connected to the agent.

Reporting
Avaya ICR provides real-time monitoring and historical reporting.

In real-time monitoring, you can view the application and queued call status in real-time. In the
status, you can view the calls for each applications, call for a particular skill, or calls for a
particular call center.

In the historical reporting, you can view the details of calls that ICR Call Control Application
(CCA) sessions handled and processed. The report includes information from the time a call
arrives in the ICR CCA session up to the call exit from the ICR CCA session.

ICR Pluggable Data Connector (PDC)
ICR Plugable Data Connector (PDC) is a connector between Self Service Application (SSA)
and ICR Core.

ICR PDC is built to integrate ICR into Avaya Aura® Orchestration Designer. ICR PDC is a
generic connector, which an application developer can use without knowledge of call centers
and ICR Core. The purpose of ICR PDC is to provide a SIP URI, which is the routing destination
for a skill.

Sample Applications
If you wish to use sample templates to start definition of segmentation and wait treatment,
Avaya ICR provides the following sample Orchestration Designer VXML applications to
demonstrate how caller segmentation, wait treatment, and self-service applications can be
incorporated into an ICR application. These applications are reusable templates that can be
further customized to meet customer scenarios.

• SSA - Self Service Application
• WTA - Wait Treatment Application
• EHA - Error Handling application

Introduction
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Avaya Aura® Experience Portal integration
Seamless integration with Avaya Aura® Experience Portal for:

• Administration, Configuration, Management, Serviceability and Licensing.
• User management and assigning ICR specific roles to users.
• Monitor alarms and different types of logs like audit logs, information logs, and error

logs.
• Backup and restore operations.

Components
The ICR architecture consists of the following three components:

• ICR Admin on page 13

• ICR Core on page 14

• ICR Call Control Application (CCA)  on page 14

• ICR Pluggable Data Connector (PDC) on page 14

ICR Admin
ICR Admin provides configuration and administration of:

• ICR components, such as core, skills, VDNs, call centers, and business hours and
holidays. For each component, you can access the corresponding Web page and
configure the associated parameters for that component. ICR Core uses call centre, skill,
and VDN information to identify the best resource available for a call.

• ICR applications, such as Self Service Application (SSA), Wait Treatment Applications
(WTAs), Error Handling Applications (EHAs), and Non Business Hours Application.

• ICR reports, such as standard report for Call Control Application (CCA) sessions.

• ICR application and queued calls

• ICR licenses for core and reports.

• ICR logs, such as audit logs, alarms and events.

• ICR user roles, such as ICR administration and ICR reporting.

In a single system setup or a multisystem setup, ICR Admin is deployed on a primary
Experience Portal Manager (EPM) system.

Components
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ICR Core
ICR Core routes the calls to the best resource available. ICR Core consists of a skill selection
module called Best Service Routing (BSR) to route calls to the Communication Manager (CM).
BSR module utilizes Avaya’s Vector capability that uses Expert Agent Selection (EAS) for
making routing decisions and provides the best location or skilled agent to which the call can
be queued.

In a single system setup, ICR Core is deployed on a primary Experience Portal Manager (EPM)
system and in a multisystem setup, ICR Core is either deployed on an auxiliary Experience
Portal Manager (EPM) system or on a standalone system.

ICR Call Control Application (CCA)
Call Control Application (CCA) is a CCXML application that coordinates all the call activities,
move calls between dialogs, and queue calls at a contact center. When a call arrives, ICR CCA
answers the call and launches the Self Service Application (SSA). The SSA handles the call
and if the caller requires additional information with the self services, CCA launches the Wait
Treatment Application (WTA) and a call is queued in the call center for an agent. The CCA re-
queues a call to a different CM in case of a CM failure.

The Error Handling Application (EHA) handles errors in a call flow.

ICR Applications are Orchestration Designer based application. ICR provides following sample
Application:

• SSA: Self service application

• WTA: Wait Treatment application

• EHA: Error Handling application

You can further customize the above sample applications according to your requirements.

In a single system setup, ICR CCA is deployed on a primary Experience Portal Manager (EPM)
system and in a multisystem setup, ICR CCA is either deployed on an auxiliary Experience
Portal Manager (EPM) system or on a standalone system.

ICR Pluggable Data Connector (PDC)
ICR Pluggable Data Connector (PDC) is a connector between Self Service Application (SSA)
and ICR Core. ICR PDC is built to integrate into Orchestration Designer. ICR PDC is a generic
connector which an application developer can use without knowledge of call centers and ICR
Core. The purpose of ICR PDC is to provide a SIP URI, which is the routing destination for a
skill.

Introduction
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ICR PDC also does the load balancing of skill selection requests that arrives across multiple
ICR Cores.

Components
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Chapter 2: Deployment Scenarios for ICR

Deploying ICR
You can deploy the ICR components; ICR Core and ICR CCA either on a primary or an auxiliary
Experience Portal Manager system or on a standalone system. However, you must deploy the
ICR Admin component on a primary Experience Portal Manager system. Based on the
scalability, load balancing and failover requirement, you can create multiple instances of ICR
Core and ICR CCA.

Host the ICR Core and ICR CCA on the Tomcat Application server provided with the
installer.

You can deploy sample ICR VXML applications along with ICR PDC on an application server
provided by a customer. You can also change the sample VXML application according to your
requirements.

ICR deployment models
Single system setup
In a single system setup, deploy ICR components, such as ICR Admin, ICR Core, and ICR
CCA on a primary Experience Portal Manager system and deploy ICR Applications on the
same system or on another application server.

Multisystem setup
In a multisystem setup, deploy ICR component, such as ICR Admin on a Primary Experience
Portal Manager system and deploy ICR Core and ICR CCA on one or more auxiliary
Experience Portal Manager systems or on a standalone system.
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Deploying ICR in the single site contact center
environment

Single site contact center model consist of:

• SIP gateway or Session Border Controller (SBC)

• Session Manager

• Experience Portal Manager components

• ICR components

• One or more Communication Manager in one site
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Deploying ICR in the single data center and multiple contact
centers environment

A single data center model with multiple contact centers consist of a single data center having
a common ingress point for all calls arriving in the system. This data center will comprise of
SIP gateway or Session Border Controller (SBC), Session Manager, Experience Portal
Manager, ICR components hosted in one place. There will be multiple contact centers with
multiple Communication Manager outside the data center.

 

 

Deploying ICR in the multiple data centers and multiple
contact centers environment

In a multiple data center model, multiple contact centers consists of each datacenter having
ingress point for calls arriving in their system. These data center will comprise of SIP gateway
or Session Border Controller (SBC), Session Manager, Experience Portal Manager, ICR

Deploying ICR in the single data center and multiple contact centers environment
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components hosted in one place. There will be multiple contact centers with multiple
Communication Manager outside data centers. The Avaya session manager across data
centers will leverage distributed Session Manager model.

ICR Monitor and Standard Reports will be available in Experience Portal Manager using
centralized reporting database.

 Note:
For the configuration of external reporting database, refer to the Administration guide of
Experience Portal Manager, available at the Avaya support site: http://support.avaya.com.
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Chapter 3: Installing Intelligent Customer
Routing (ICR)

Prerequisites for installing ICR
ICR is a managed application of Avaya Aura® Experience Portal. Therefore, hardware and
software specifications applicable for Avaya Aura® Experience Portal are also applicable for
ICR. However, following are the additional prerequisites for ICR.

Software prerequisites

• Avaya Aura® Communication Manager 5.2.1 Service Pack 8 or later, 6.0.1 Service pack
2 or later, or 6.2 Service Pack 2.01

• Avaya Aura® Session Manager 5.2, 6.1, or 6.2
• Avaya Aura® Experience Portal 6.0 Service Pack 3
• Application Server
• Speech Server

Hardware prerequisites

• RAM: 4-GB or more
• SIP Gateways or Session Border Controller (SBC)

 Note:
For more information about the hardware requirements, see the Minimum (Linux) server
machine hardware requirements topic in the Avaya Aura® Experience Portal
documentation.

Operating system prerequisites

• Disable the firewall or antivirus software running on the system.
• Set selinux to the permissive mode. For more information, see the Linux operating

system documentation.
• Synchronize the time between all the Avaya Aura® Experience Portal and ICR systems.
• Use the new ssh session for installing ICR and not the same session used for installing

Avaya Aura® Experience Portal.
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About ICR installation
ICR consists of the following components:

• ICR Admin

• ICR Call Control Application (CCA)

• ICR Core

To install the ICR components, run the ICR installer on a single system or install individual
components on multiple systems.

 Note:
When you install ICR without installing the ICR licenses, the License page of Avaya Aura®

Experience Portal displays the license count of ICR Core and ICR Reporting as 1. This count
indicates that you can use ICR for an initial trial period of 30 days. After the trial period, you
must install the ICR license to continue using ICR. For more information about installing ICR
licenses, see the ICR Administration guide.

Single system installation
You can install all the ICR components on a single system. However, you must install the ICR
Admin component on the primary Experience Portal Manager system.

 Note:
In the single system installation of ICR, you must configure different SIP listener ports for
Media Processing Platform (MPP) and ICR Core. For ICR Core, you can modify the
ICRSipTCPPort property in the icrcore.properties file available in the
$AVAYA_ICRCORE_HOME/tomcat/conf directory.

Multisystem installation
You can install ICR components separately on multiple systems.

Following are the system requirements for multisystem installation:

• ICR Admin

You must install this component on a primary Experience Portal Manager system.
• ICR CCA and ICR Core

You can install these components on an auxiliary Experience Portal Manager system or
a standalone Linux system.

 Note:
If you are installing ICR Core or ICR CCA on a standalone Redhat Enterprise Linux
system, follow the prerequisites mentioned in the Customer-provided operating system
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installation chapter of the Implementing Avaya Aura® Experience Portal on multiple
servers guide.

 Important:
If you install ICR CCA and ICR Core on a standalone Linux system, the remote access
using Secured Access Link (SAL) is not supported.

Silent installation
You can install ICR components in a silent mode. Silent installation is useful when you know
the required install settings and you do not want to change the settings. Install ICR in a silent
mode only when you know the install settings correctly.

 Note:
After you complete installing the ICR components, you must configure the installed ICR
components. For more information about configuring ICR components, see the
Administering Intelligent Customer Routing guide.

Installing ICR Admin
Before you begin

• Check the prerequisites in Prerequisites for installing ICR on page 21.
• If you are installing Avaya Aura® Experience Portal for the first time, see the Avaya Aura®

Experience Portal documentation on the Avaya support site at: http://
support.avaya.com.

Procedure

1. Mount the ICR installation media on the primary Experience Portal Manager system
where you want to install ICR Admin.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
The system displays the message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y, and press Enter to accept the license agreement.

Installing ICR Admin

Implementing Intelligent Customer Routing (ICR) May 2014     23

http://support.avaya.com
http://support.avaya.com


6. On the Choose Install Path screen, press Enter to select the default path for
installation.
By default, the installer displays the path as: /opt/Avaya/ICR. However, you can
provide a new absolute directory path.

7. On the Choose Product Features screen, the system displays the message:
Please choose the Features to be installed by this
installer.

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.

• To go back to the previous page, type back and press Enter.

• To select or clear a feature, enter the feature number separated by a
comma.

• To cancel the installation at any time, type quit and press Enter.

8. Type 1, and press Enter to select ICR Admin.
The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are installing. The information includes, the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.

 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type. For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.

Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:    Installed Version:    New Version:    Install Type:
ICRAdmin        Not Installed        6.0.3.0.x    Full Install

Continue with installation? (Y/N):
========================================================================

10. Type Y, and press Enter to continue.
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The installer checks the prerequisites required for ICR Admin and displays the
summary similar to the following:
========================================================================
ICR Admin Prerequisite Check status
-----------------------------------

Prerequisite                 Expected result              Found
Is EPM installed?            YES                          YES
Is EPM Version supported?    6.x                          6.0.3.0.x

PRESS <ENTER> TO CONTINUE:
========================================================================

11. Press Enter to continue.
To install ICR Admin, the installer must stop the Experience Portal Manager service.
Therefore, the ICR Admin installer displays the Stopping EPM service screen
to confirm stopping of the Experience Portal Manager service.

The default option is Continue.
========================================================================
Stopping EPM service
--------------------

Installer will now proceed to stop Experience Portal Management service.

Do you want to continue?

  ->1- Continue
    2- Exit

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
========================================================================

12. Press Enter to continue, or type 2 and press Enter to exit the installer.
The system displays the Pre-Installation Summary screen with the summary
similar to the following:
========================================================================
Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
    /opt/Avaya/ICR

Product Features:
    ICRAdmin

Disk Space Information (for Installation Target):
    Required:  40,492,255 bytes
    Available: 1,264,046,080 bytes

PRESS <ENTER> TO CONTINUE:
========================================================================
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13. Press Enter to continue.
The installer starts installing ICR Admin.
While installing ICR Admin, the ICR Admin installer displays the Starting EPM
service screen to confirm about starting the Experience Portal Manager
service.
========================================================================
Starting EPM service
--------------------

Installer will now proceed to start EPM and dependent services. This 
operation will take some time.

ICRAdmin logs will be created at

/opt/Avaya/ICR/ICRAdmin/logs/ICRAdmin_InstallLog.log and
/opt/Avaya/ICR/ICRAdmin/logs/icr_install_script.log. 

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
========================================================================

 Note:
By default, the installer creates the install logs of ICR Admin in the
ICRAdmin_InstallLog.log and admin_install_script.log files
located in the $AVAYA_ICRADMIN_HOME/logs directory. After the installation,
check the log files for any errors.

The $AVAYA_ICRAdmin_HOME variable is available in a new Linux session and
not in the same installation session.

14. Press Enter to continue.
The installer installs ICR Admin and displays a message for successful
installation.

15. Press Enter to exit the installer.

Next steps
Verify that the Experience Portal Manager service is running:

service vpms status

Installing ICR CCA
Before you begin
Check the prerequisites in Prerequisites for installing ICR on page 21.
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Procedure

1. Mount the ICR installation media on the system where you want to install ICR
CCA.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
The system displays the message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y, and press Enter to accept the license agreement.

6. On the Choose Install Path screen, press Enter to select the default path for
installation.
By default, the installer displays the path as: /opt/Avaya/ICR. However, you can
provide a new absolute directory path.

7. On the Choose Product Features screen, the system displays the message:
Please choose the Features to be installed by this
installer.

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.

• To go back to the previous page, type back and press Enter.

• To select or clear a feature, enter the feature number separated by a
comma.

• To cancel the installation at any time, type quit and press Enter.

8. Type 2, and press Enter to select ICR CCA.
The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are installing. The information includes, the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.
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 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

=========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type. For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.

Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:        Installed Version:        New Version:        Install Type:
ICRCCA            Not Installed            6.0.3.0.x        Full Install

Continue with installation? (Y/N):
=========================================================================

10. Type Y, and press Enter to continue.
The installer checks the prerequisites required for ICR CCA and displays the
summary similar to the following:
=========================================================================
ICR CCA/ICR Core Prerequisite Check status
------------------------------------------

Prerequisite        Expected result            Found
OS & Version:        AVAYA Linux/RHEL6.x        Red Hat Enterprise Linux  6.0
Memory:            4 GB                4.021 GB

PRESS <ENTER> TO CONTINUE:
=========================================================================

11. Press Enter to continue.
The system displays the Primary EPM Server screen, which prompts: EPM IP
ADDRESS (DEFAULT: XXX.XXX.XXX.XXX):.

By default the system displays the IP address of the local system.
12. Type the IP address of the primary Experience Portal Manager system, and press

Enter.
The system displays the Pre-Installation Summary screen, which displays
the summary similar to the following:
=========================================================================
Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
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    /opt/Avaya/ICR

Product Features:
    ICRCCA

Disk Space Information (for Installation Target):
    Required:  275,603,020 bytes
    Available: 1,929,621,504 bytes

PRESS ENTER TO CONTINUE:
=========================================================================

13. Press Enter to continue.
The installer starts installing ICR CCA.
While installing ICR CCA, the ICR CCA installer displays the Starting ICRCCA
service screen to confirm about starting the ICR CCA service.

=========================================================================
Starting ICRCCA service...
--------------------------

Installer will now proceed to start ICRCCA and dependent services. This 
operation will take some time.

ICRCCA logs will be created at

/opt/Avaya/ICR/ICRCCA/logs/ICRCCA_InstallLog.log and
/opt/Avaya/ICR/ICRCCA/logs/cca_install_script.log. 

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, ICR creates the install logs of ICR CCA in the
ICRCCA_InstallLog.log and cca_install_script.log files located in
the $AVAYA_ICRCCA_HOME/logs directory. After installation, check the log files
for any errors.

The $AVAYA_ICRCCA_HOME variable is available in a new Linux session and
not in the same installation session.

14. Press Enter to continue.
The installer installs ICR CCA and displays a message to confirm the successful
installation.

15. Press Enter to exit the installer.

Next steps
Verify that the ICR CCA service is running:

service icrcca status
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Installing ICR Core
Before you begin
Check the prerequisites in Prerequisites for installing ICR on page 21.

Procedure

1. Mount the ICR installation media on the system where you want to install ICR
Core.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
The system displays the message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y, and press Enter to accept the license agreement.

6. On the Choose Install Path screen, press Enter to select the default path for
installation.
By default, the installer displays the path as: /opt/Avaya/ICR. However, you can
provide a new absolute directory path.

7. On the Choose Product Features screen, the system displays the message:
Please choose the Features to be installed by this
installer.

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.

• To go back to the previous page, type back and press Enter.

• To select or clear a feature, enter the feature number separated by a
comma.

• To cancel the installation at any time, type quit and press Enter.

8. Type 3, and press Enter to select ICR Core.
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The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are installing. The information includes, the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.

 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

=========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type. For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.

Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:        Installed Version:        New Version:        Install Type:
ICRCore            Not Installed            6.0.3.0.x        Full Install

Continue with installation? (Y/N):
=========================================================================

10. Type Y, and press Enter to continue.
The installer checks the prerequisites required for ICR Core, and displays the
summary similar to the following:
=========================================================================
ICR CCA/ICR Core Prerequisite Check status
------------------------------------------

Prerequisite        Expected result            Found
OS & Version:        AVAYA Linux/RHEL6.x        Red Hat Enterprise Linux  6.0
Memory:            4 GB                4.021 GB

PRESS <ENTER> TO CONTINUE:
=========================================================================

11. Press Enter to continue.
The system displays the Primary EPM Server screen, which prompts: EPM IP
ADDRESS (DEFAULT: XXX.XXX.XXX.XXX):.

By default the system displays the IP address of the local system.

12. Type the IP address of the primary Experience Portal Manager system, and press
Enter.

13. On the EPM Product ID screen, type the correct product ID of Avaya Aura®

Experience Portal.
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You can find the product ID of Avaya Aura® Experience Portal on the System
Monitor page.
a. From the Experience Portal Manager main menu in the left navigation pane,

click Real-Time Monitoring > System Monitor.
b. In the Server Name column, click the EPM link.

In the General Information area, the Product ID field displays the product ID
of Avaya Aura® Experience Portal.

14. Press Enter to continue.
The system displays the Pre-Installation Summary screen, which displays
the summary similar to the following:
=========================================================================
Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
    /opt/Avaya/ICR

Product Features:
    ICRCore

Disk Space Information (for Installation Target):
    Required:  427,953,696 bytes
    Available: 2,074,517,504 bytes

PRESS ENTER TO CONTINUE:
=========================================================================

15. Press Enter to continue.
The installer starts installing ICR Core.

While installing ICR Core, the ICR Core installer displays the Starting ICRCore
service screen to confirm the start of the ICR Core service.

=========================================================================
Starting ICRCore service...
---------------------------

Installer will now proceed to start ICRCore and dependent services. This 
operation will take some time.

ICRCore logs will be created at

/opt/Avaya/ICR/ICRCore/tomcat/logs folder.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, ICR creates the Core logs in the $AVAYA_ICRCORE_HOME/tomcat/
logs directory and the installer log file ICRCore_InstallLog.log in the
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$AVAYA_ICRCORE_HOME directory. After installation, check the log files for any
errors.

The $AVAYA_ICRCORE_HOME variable is available in a new Linux session and
not in the same installation session.

16. Press Enter to continue.
The installer installs ICR Core and displays a message for successful installation.

17. Press Enter to exit the installer.

Next steps

1. Verify that the httpd service is configured for an auto start.

Enter the following command to check the httpd service auto start status:

chkconfig httpd –– list
Command output:
httpd      0:off   1:off   2:on    3:on    4:on    5:on    6:off

In the command output, check that the levels 2 to 5 display the status as on.

If the status for the levels 2 to 5 is off, configure the httpd service for auto start
using the following command:

chkconfig httpd on
2. Reboot the system and verify that the ICR Core services are running:

service icrcore status
service terracottaSrv status
service icrwebservice status
service httpd status

Installing ICR on a single system
Before you begin
Check the prerequisites in Prerequisites for installing ICR on page 21.
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About this task
To install ICR on a single system, install the following ICR components on a single system:

• ICR Admin
• ICR Core
• ICR CCA

You can install all the ICR components on the single Avaya Aura® Experience Portal system,
where primary Experience Portal Manager is running.

 Note:

• Running all the ICR components on single system can have an impact on ICR
performance. Therefore, you must install ICR on a single system in a development
environment.

• When installing ICR on a single system, you must configure different SIP listener ports
for Media Processing Platform (MPP) and ICR Core. For ICR Core, you can modify the
ICRSipTCPPort property in the icrcore.properties file located in the
$AVAYA_ICRCORE_HOME/tomcat/conf directory. For MPP, you can modify the SIP
listener ports on the VoIP Connection page of Experience Portal Manager.

• On the Avaya Session Manager system, create the SIP entity link only for MPP and
mark that link as trusted. Do not create a separate SIP entity link for ICR Core because
ICR Core and MPP resides on a single system.

Procedure

1. Mount the ICR installation media on the primary Experience Portal Manager system
where you want to install all the ICR components.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin, and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
The system displays the message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y, and press Enter to accept the license agreement.

6. On the Choose Product Features screen, press Enter to select the default
path for installation.
By default, the installer displays the path as: /opt/Avaya/ICR. However, you can
provide a new absolute directory path.

Installing Intelligent Customer Routing (ICR)

34     Implementing Intelligent Customer Routing (ICR) May 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Implementing Intelligent Customer Routing (ICR)


7. On the Choose Product Features screen, the system displays the message:
Please choose the Features to be installed by this
installer.

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.

• To go back to the previous page, type back and press Enter.
• To select or clear a feature, enter the number for the feature separated by

a comma.
• To cancel the installation at any time, type quit and press Enter.

8. Type 1,2,3, and press Enter to select ICR Admin, ICR CCA, and ICR Core
application.
The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are installing. The information includes, the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.

 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

=========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type. For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.

Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:    Installed Version:    New Version:        Install Type:
ICRAdmin    Not Installed            6.0.3.0.x        Full Install
ICRCCA        Not Installed        6.0.3.0.x        Full Install
ICRCore        Not Installed        6.0.3.0.x        Full Install

Continue with installation? (Y/N):
=========================================================================

10. Type Y, and press Enter to continue.
The installer checks the prerequisites required for ICR Admin, and displays the
summary similar to the following:
=========================================================================
ICR Admin Prerequisite Check status
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-----------------------------------

Prerequisite                    Expected result                Found
Is EPM installed?                YES                    YES
Is EPM Version supported?            6.x                    6.0.3.0.x

PRESS <ENTER> TO CONTINUE:
=========================================================================

11. Press Enter to continue.
To install ICR Admin, the installer must stop the Experience Portal Manager service.
Therefore, the ICR Admin installer displays the Stopping EPM service screen
to confirm stopping of the Experience Portal Manager service.

The default option is Continue.
=========================================================================
Stopping EPM service
--------------------

Installer will now proceed to stop Experience Portal Management service.

Do you want to continue?

  ->1- Continue
    2- Exit

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
=========================================================================

12. Press Enter to continue or type 2, and press Enter to exit the installer.
The installer checks for prerequisites before installing ICR Core and ICR CCA, and
shows the summary similar to the following:
=========================================================================
ICR CCA/ICR Core Prerequisite Check status
------------------------------------------

Prerequisite        Expected result            Found
OS & Version:        AVAYA Linux/RHEL6.x        Red Hat Enterprise Linux  6.0
Memory:            4 GB                4.152 GB

PRESS <ENTER> TO CONTINUE:
=========================================================================

13. Press Enter to continue.
The system displays the Primary EPM Server screen, which prompts: EPM IP
ADDRESS (DEFAULT: XXX.XXX.XXX.XXX):.

By default the system displays the IP address of the local system.

14. Type the IP Address of the primary Experience Portal Manager, system and press
Enter.

15. On the EPM Product ID screen, type the Product ID of the Avaya Aura®

Experience Portal system.
You can find the product ID of Avaya Aura® Experience Portal on the System
Monitor page.
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a. From the Experience Portal Manager main menu in the left navigation pane,
click Real-Time Monitoring > System Monitor.

b. In the Server Name column, click the EPM link.
c. In the General Information area, the Product ID field displays the product ID

of Avaya Aura® Experience Portal.

16. Press Enter to continue.
The system displays the Pre-Installation Summary screen, which displays
the summary similar to the following:
=========================================================================
Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
    /opt/Avaya/ICR

Product Features:
    ICRAdmin,
    ICRCCA,
    ICRCore

Disk Space Information (for Installation Target):
    Required:  731,811,129 bytes
    Available: 2,039,353,344 bytes

PRESS ENTER TO CONTINUE:
=========================================================================

17. Press Enter to continue.
The installer starts installing the ICR components. While installing ICR Admin, the
installer displays the Starting EPM service screen to confirm starting of the
Experience Portal Manager service.
=========================================================================
Starting EPM service
--------------------

Installer will now proceed to start EPM and dependent services. This 
operation will take some time.

ICRAdmin logs will be created at

/opt/Avaya/ICR/ICRAdmin/logs/ICRAdmin_InstallLog.log and
/opt/Avaya/ICR/ICRAdmin/logs/icr_install_script.log.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================
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 Note:
By default, ICR creates the Admin logs in the ICRAdmin_InstallLog.log and
icr_install_script.log files located in the $AVAYA_ICRADMIN_HOME/
logs directory. Check the log files for any post installation errors.

The $AVAYA_ICRADMIN_HOME variable is available in the new Linux session
and not in the same installation session.

18. Press Enter to continue.
The installer completes the installation process of ICR Admin, and displays a
message for successful installation.

19. Press Enter to continue.
The installer displays the Starting ICRCCA service screen to confirm starting
of the ICR CCA service.
=========================================================================
Starting ICRCCA service...
--------------------------

Installer will now proceed to start ICRCCA and dependent services. This 
operation will take some time.

ICRCCA logs will be created at

/opt/Avaya/ICR/ICRCCA/logs/ICRCCA_InstallLog.log and
/opt/Avaya/ICR/ICRCCA/logs/cca_install_script.log.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, ICR create the CCA logs in the ICRCCA_InstallLog.log and
cca_install_script.log files located in the $AVAYA_ICRCCA_HOME/
logs directory. After installation, check the log files for any errors.

The $AVAYA_ICRCCA_HOME variable is available in a new Linux session and
not in the same installation session.

20. Press Enter to continue.
The installer installs ICR CCA and displays a message for successful installation.

21. Press Enter to continue.
The installer displays the Starting ICRCore service screen to confirm
starting of the ICR Core service.
=========================================================================
Starting ICRCore service...
---------------------------

Installer will now proceed to start ICRCore and dependent services. This 
operation will take some time.
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ICRCore logs will be created at

/opt/Avaya/ICR/ICRCore/tomcat/logs folder.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, ICR creates the Core logs in the ICRCore_InstallLog.log file
located in the $AVAYA_ICRCORE_HOME directory. After installation, check the log
files for any errors.

The $AVAYA_ICRCORE_HOME variable is available in the new Linux session
and not in the same installation session.

22. Press Enter to continue.
The installer installs ICR Core and displays a message of successful installation.

23. Press Enter to exit the installer.

Next steps

1. Reboot the system.

 Important:
You must reboot the system and log in to a new Linux session because the
updated environment variables are available only in the new session.

2. Verify that the Experience Portal Manager service is running:

service vpms status
3. Verify that the ICR CCA service is running:

service icrcca status
4. Verify that the ICR Core services are running:

service icrcore status
service terracottaSrv status
service icrwebservice status
service httpd status

 Note:
If the icrcore service is not running, verify that the different ports are configured
for Media Processing Platform (MPP) and ICR Core. To change the port for ICR
Core, configure the ICRSipTCPPort or ICRSipTLSPort properties in the
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icrcore.properties file. For more information on icrcore.properties
file, see ICR Core property file description  on page 111.

After you make the changes in the icrcore.properties file, run the command
service icrcore start to start the ICR Core service.

Installing ICR Core on multiple systems
Procedure

1. Install ICR Core on the required systems.
For more information, see Installing Core on page 30.

2. Configure Terracotta server in high availability mode on each system where you
installed ICR Core.

Related topics:
Configuring Terracotta server in the cluster mode on page 40

Configuring Terracotta server in the cluster mode
Before you begin

1. On each ICR Core system, add the IP address and the host names of the all ICR
Core system in the /etc/hosts file.

2. Synchronize the time between all the ICR Core systems.
3. Before you configure Terracotta server for high availability, stop all the ICR Core

and Terracotta server instances.

About this task
ICR uses cache to store the skill related information, such as BSR data of all polling VDN’s
configured for a skill. When ICR PDC requests for best destination from ICR Core for a
particular skill, ICR Core checks the cache for best destination information for the specified
skill. If the information is available in cache and has not expired (based on the cache freshness
configuration), ICR Core returns the best destination from cache. If the information in cache
has expired or is not available, ICR Core initiates BSR poll to ACD, computes the best
destination, updates the cache, and responds with the best destination to ICR PDC.

To minimize the polling request to ACDs, the cache is shared across all ICR Core in the system
using third party software Terracotta. The Terracotta software is automatically installed on the
system where you install ICR Core. Therefore, each ICR Core system has a local Terracotta
server. You must configure Terracotta in a cluster mode to make the cache shared across all
ICR Core.
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In a Terracotta cluster mode only one server is in ACTIVE state and all other Terracotta servers
are in PASSIVE state. With the cluster mode configuration, Terracotta servers become highly
available with no single point of failure.

Perform the following steps to configure the Terracotta server in cluster mode.

Procedure

1. Log in to the ICR Core system on which you want to configure Terracotta in the
cluster mode.

2. Log on to the Linux system either locally as a root user or remotely as a non-root
user and change the user to root by using the su - command.

3. If you are an Avaya Services representative and if you are using Avaya Enterprise
Linux or if the Avaya Service accounts are installed on this Core system:

• Log on to the local Linux system as a sroot user.

• Or log on remotely as a non-root user and change the user to sroot by entering
the su - sroot command.

4. Enter the following command to stop ICR Core instances on each system.
/sbin/service icrcore stop

5. Enter the following command to stop the Terracotta server instances on each
system.
/sbin/service terracottaSrv stop

6. On the ICR Core system, which you want to make an active Terracotta server, go
to the $AVAYA_ICRCORE_HOME directory:

a. From the directory, back up the icr-tc-config.xml configuration file using
the following command:
cp icr-tc-config.xml icr-tc-config.xml.old

b. Open the icr-tc-config.xml configuration file to edit.
c. In the configuration file, search for the <server> tag.
d. In the <server> tag:

• Change the value of the host attribute with the IP address of the ICR Core
system .

• Keep the default value of the name attribute as it is.

For example:
=====================================================================
<server host="192.168.0.1" name="Server1">
    <dso>
        <persistence>
            <mode>Permanent-store</mode>
        </persistence> 
    </dso>
</server>
=====================================================================
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e. In the same configuration file, add another <server> tag for the ICR Core system
on which you want to host another instance of Terracotta server.
You can copy and paste the existing <server> tag.

f. In the new <server> tag:

• Change the value of the host attribute to the IP address of another ICR
Core system.

• Change the value of the name attribute to Server2 .

For example:
====================================================================
<server host="192.168.0.2" name="Server2">
    <dso>
        <persistence>
            <mode>Permanent-store</mode>
        </persistence> 
    </dso>
</server>
====================================================================

g. In the same configuration file, search for the <ha> tag and remove the
commenting mark given to the tag.
For example:
====================================================================
<ha>
    <mode>networked-active-passive</mode>
        <networked-active-passive>
            <election-time>5</election-time>
        <networked-active-passive>
</ha>
=====================================================================

h. Save the changes and close the file.
i. Go to the $AVAYA_ICRCORE_HOME/bin directory.
j. Open the startup configuration script file start-tc-server.sh to edit.
k. Verify that the string Server1 is present in the following code line.

$icrhome/terracotta-server/bin/start-tc-server.sh -n Server1 -f
$icrhome/icr-tc-config.xml > $TEMP_FILE 2>&1 &

l. Start the active Terracotta server (Server1) using the following command.
/sbin/service terracottaSrv start

m. Verify whether the Terracotta server started in the active mode.
Run the command:$AVAYA_ICRCORE_HOME/terracotta-server/bin/
server-stat.sh
The system displays the following result:
===========================================================
localhost.health: OK
localhost.role: ACTIVE
localhost.state: ACTIVE-COORDINATOR
localhost.jmxport: 9520
===========================================================
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7. On the ICR Core system, which you want to make the passive Terracotta server,
go to the $AVAYA_ICRCORE_HOME directory:

a. Back up the icr-tc-config.xml configuration file using the following
command.
cp icr-tc-config.xml icr-tc-config.xml.old

b. Copy the icr-tc-config.xml file available in the $AVAYA_ICRCORE_HOME
directory on the ICR Core system with active Terracotta server (Server1) to the
ICR Core system with passive Terracotta server (Server2).

c. If $AVAYA_ICRCORE_HOME on the ICR Core system with active Terracotta
Server (Server1) is different from the $AVAYA_ICRCORE_HOME on the ICR
Core system with passive Terracotta Server (Server2), edit the copied icr-
tc-config.xml file and change the <logs> tag with the correct ICR Core
installation path.

d. After copying the file to the ICR Core system with passive Terracotta server
(Server2), ensure that the file ownership and group ownership for the icr-tc-
config.xml file are avayavp:avayavpgroup.

 Note:
If the file ownership and group ownership are not avayavp:avayavpgroup,
run the chown avayavp:avayavpgroup icr-tc-config.xml
command to change the file and group ownerships.

e. Go to the $AVAYA_ICRCORE_HOME/bin directory.
f. Open the startup configuration script file start-tc-server.sh.
g. Change the string Server1 to Server2 in the following code line.

For example:
$icrhome/terracotta-server/bin/start-tc-server.sh -n Server2 -f
$icrhome/icr-tc-config.xml > $TEMP_FILE 2>&1 &

h. Save the changes and close the file.
i. Start the passive Terracotta server named as Server2 using the following

command:.
/sbin/service terracottaSrv start

j. Verify that the Terracotta server (Server2) started in the passive mode.
Run the command:$AVAYA_ICRCORE_HOME/terracotta-server/bin/
server-stat.sh
The system displays the following result:
===========================================================
localhost.health: OK
localhost.role: PASSIVE
localhost.state: PASSIVE-STANDBY
localhost.jmxport: 9520
===========================================================

8. (Optional) If required, configure more Terracotta servers in the passive mode.
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a. Stop the all the running instances of Terracotta and ICR Core servers. In this
case, Server1, Server2, and Server3.

b. On the Server1, open the icr-tc-config.xml configuration file to edit.
c. In the file, add a new <server> tag and change the host and name attributes to

point to Server3.
For example:
=====================================================================
<server host="192.168.0.3" name="Server3">
    <dso>
        <persistence>
            <mode>Permanent-store</mode>
        </persistence> 
    </dso>
</server>
=====================================================================

d. Start the active Terracotta server (Server1) using the following command.
/sbin/service terracottaSrv start

e. Verify whether the Terracotta server (Server1) started in the active mode.
Run the command: $AVAYA_ICRCORE_HOME/terracotta-server/bin/
server-stat.sh
The system displays the following result:
===========================================================
localhost.health: OK
localhost.role: ACTIVE
localhost.state: ACTIVE-COORDINATOR
localhost.jmxport: 9520
===========================================================

f. On the Server2 and Server3 system, perform the substeps mentioned in the
step 7.

9. Start each passive Terracotta server using the following command:
/sbin/service terracottaSrv start

10. Start all the ICR Core systems using the following command:
/sbin/service icrcore start

 Note:
After configuring all ICR Core system in HA mode, if you plan to remove one of
the configured ICR Core system out of network for maintenance, ensure that the
server entries are removed from the icr-tc-config.xml.

Installing Intelligent Customer Routing (ICR)

44     Implementing Intelligent Customer Routing (ICR) May 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Implementing Intelligent Customer Routing (ICR)


Installing ICR using the silent installer
Before you begin
If you are installing Avaya Aura® Experience Portal for the first time, see the Avaya Aura®

Experience Portal documentation on the Avaya support site at http://support.avaya.com.

 Note:
Install ICR Admin only on the system on which Experience Portal Manager is running.

Procedure

1. Mount the ICR installation media.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Copy icr_silent_install.properties file from the mount point directory to
a temporary directory on the system.

3. Edit the icr_silent_install.properties file.
The file contains the following:
===================================================================
# Replay feature output
# ---------------------
# This file was built by the Replay feature of InstallAnywhere.
# It contains variables that were set by Panels, Consoles or Custom Code.

#Choose Install Folder
#---------------------
USER_INSTALL_DIR=/opt/Avaya/ICR

#All selected ICR components will be installed under this directory
#Choose Product Features
#-----------------------
CHOSEN_INSTALL_FEATURE_LIST=ICRAdmin,ICRCCA,ICRCore
CHOSEN_INSTALL_SET=Typical

#Install
#-------
-fileOverwrite_/opt/Avaya/ICR/ICR_Uninstaller/Uninstall_ICR.lax=Yes

#VoicePortal Product Key
#-----------------------
VOICEPORTAL_PRODUCT_KEY_1=1234567890

#Inputs to install ICR Core and ICR CCA.
#VPMS IP Address
#---------------
VPMS_IP_ADDRESS_1=127.0.0.1

#
# Set the following variables to "true" if performing an upgrade operation
#
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ICRADMIN_UPGRADE_REQUIRED=false
ICRCCA_UPGRADE_REQUIRED=false
ICRCORE_UPGRADE_REQUIRED=false
#
# Used by ICR Admin installer to decide whether to EPM or not. 
# 0 - Indicates to stop EPM service before admin installation
# 1 - Indicates not to stop EPM service before admin installation
# Recommended to set this value as 0 otherwise ICRAdmin menu's will not be 
visible till vpms is restarted manually.
#
PROMPT_STOP_EPM=0
===================================================================

The details of the fields present in the icr_silent_install.properties file
are:

Parameter Description

USER_INSTALL_DIR The ICR installation path.
By default the installer displays the path
as: /opt/Avaya/ICR. However,
you can provide different install path.
Do not set the path as: /root/.

CHOSEN_INSTALL_FEATURE_LIST The ICR component names that the
installer is installing.
By default the installer displays all the
ICR component names, such as
ICRAdmin,ICRCCA,ICRCore.
Keep the component names that you
want to install and remove the other
component names.

CHOSEN_INSTALL_SET The installation type.
The default value is Typical.
Do not change the default value.

VOICEPORTAL_PRODUCT_KEY_1 The Product ID of the Avaya Aura®

Experience Portal system.

VPMS_IP_ADDRESS_1 The IP address of the primary
Experience Portal Manager system.

ICRADMIN_UPGRADE_REQUIRED A value that the ICR installer uses only
for upgrading ICR Admin.
By default the value is set to false.

ICRCCA_UPGRADE_REQUIRED A value that the ICR installer uses only
for upgrading ICR CCA.
By default the value is set to false.

ICRCORE_UPGRADE_REQUIRED A value that the ICR installer uses only
for upgrading ICR Core.
By default the value is set to false.

PROMPT_STOP_EPM A value that the ICR Admin installer
uses to decide whether to stop
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Parameter Description

Experience Portal Manager service or
not.

 Note:

• The system does not display the installation progress. Therefore, wait until
the installation process completes.

• The installer installs ICR using the values from the
icr_silent_install.properties file.

4. Save the changes and close the file.

5. Type ./install_icr.bin -i silent -f
<Location_of_the_icr_silent_install.properties_file>/
icr_silent_install.properties, and press Enter.
Where,

• I is the mode of installation.

• f is the file location of the icr_silent_install.properties file.

 Note:
If you install ICR using the silent installer, the uninstaller uninstalls all the ICR
components silently.

Next steps

1. Verify that the httpd service is configured for an auto start.

Enter the following command to check the auto start status of the httpd service:

chkconfig httpd – –list
Command output:
httpd      0:off   1:off   2:on    3:on    4:on    5:on    6:off

In the command output, check that the levels 2 to 5 displays the status as on.

If the status for the level 2 to 5 is off, configure the httpd service for auto start using
the following command:

chkconfig httpd on
2. Reboot the system where you installed the ICR components and verify that the

following services are running:

• Experience Portal Manager service:

service vpms status
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• ICR CCA service:

service icrcca status
• ICR Core services:

service icrcore status
service terracottaSrv status
service icrwebservice status
service httpd status
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Chapter 4: Upgrading Intelligent Customer
Routing

Prerequisites for upgrading ICR
Intelligent Customer Routing (ICR) is a managed application of Avaya Aura® Experience Portal.
Therefore, Avaya Aura® Experience Portal and ICR have common hardware and software
specifications. However, ICR has some additional prerequisites.

Software prerequisites

• Avaya Aura® Experience Portal 6.0 Service Pack 3

Hardware prerequisites

• RAM: 4-GB or more

 Note:
For more information about the minimum hardware requirements, see Planning for Avaya
Aura® Experience Portal.

Operating system prerequisites

• Disable the firewall or antivirus software running on the system.
• Set selinux to the permissive mode. For more information, see the Linux operating

system documentation.
• Synchronize the time between all the Avaya Aura® Experience Portal and ICR systems.
• Use a new ssh session for upgrading ICR and not the same session used for installing

ICR.

About upgrading ICR 
Using the ICR installer, you can upgrade the earlier ICR Releases 6.x and 6.0.x to the Release
6.0.3.
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With the installer, you can upgrade the following ICR components:

• ICR Admin

• ICR Call Control Application (CCA)

• ICR Core

While upgrading, the installer retains the existing license counts and configuration of the ICR
components.

 Note:
The installer stops all the running services for all the ICR components.

You can use the installer to upgrade the ICR components on a single system or multiple
systems. The installer supports the console and the silent mode for upgrade.

Upgrade the ICR components in the following order:

1. Upgrade the ICR Admin component on the Experience Portal Manager system.

 Note:
Before upgrading, the ICR installer stops the running vpms service.

2. Upgrade the ICR PDC component installed on the Application server system.

3. Upgrade the ICR CCA component installed on a single or multiple systems. You
must upgrade all ICR CCA systems one after another and not simultaneously.

4. Upgrade the ICR Core component installed on a single or multiple systems.

Also, upgrade the ICR Core component on all the passive Terracotta servers first
and after that upgrade on the active Terracotta server.

Following are the different ways of upgrading ICR:

Single system upgrade
You can upgrade the ICR components on a single system.

Multisystem upgrade
You can upgrade the ICR components separately on multiple systems.

The following system requirements are for multisystem upgrades:

• ICR Admin

You must upgrade this component on a primary Experience Portal Manager system.
• ICR CCA and ICR Core

You can upgrade these components on an auxiliary Experience Portal Manager system
or on a standalone Linux system.
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 Note:
To upgrade ICR Core or ICR CCA on a standalone Redhat Enterprise Linux system,
follow the prerequisites mentioned in Implementing Avaya Aura® Experience Portal on
multiple servers available at the Avaya support site: http://support.avaya.com.

 Important:
To upgrade the ICR CCA and ICR Core on a standalone Linux system, the system
does not support remote access using Secured Access Link (SAL).

Silent upgrade
You can upgrade the ICR components in a silent mode. Silent upgrade is useful when you
know the required upgrade settings and you do not want to change the settings.

 Note:
After you upgrade the ICR components, you must configure the upgraded ICR components.
For more information about configuring the ICR components, see Administering Intelligent
Customer Routing.

Upgrading ICR Admin
Before you begin
Before upgrading ICR Admin, check the prerequisites in Prerequisites for upgrading ICR on
page 49.

Procedure

1. Mount the ICR installation media on the system where ICR Admin is installed.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
The system displays a message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y and press Enter to accept the license agreement.
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6. On the Choose Install Path screen, enter the path where you installed ICR
Admin and press Enter.
By default, the installer displays the path as: /opt/Avaya/ICR.

 Note:
Before upgrading ICR Admin, the installer checks if the specified path matches
the path set in the $AVAYA_ICRADMIN_HOME environment variable. If the path
does not match, the installer displays the path mismatch error screen and
prompts the user to exit the installer and run the installer again with the correct
path.

=========================================================================
Install Path Mismatch
---------------------

Installer has found a mismatch in chosen path versus installed path. ICR
component(s) cannot be upgraded to a new location.

If you have previously installed ICR components on separate location please
upgrade each component individually at installed location:

Component:    Installed At:                            New Location:
ICRADMIN    /opt/Avaya/ICRADMIN/ICRADMIN    /opt/Avaya/ICR/ICRADMIN

PRESS <ENTER> TO EXIT THE INSTALLER:
=========================================================================

7. On the Choose Product Features screen, the system displays a message:
Please choose the Features to be installed by this
installer.

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.

• To go back to the previous page, type back and press Enter.

• To select or clear a feature, enter the feature number separated by a
comma.

• To cancel the installation at any time, type quit and press Enter.

8. Type 1 and press Enter to select ICR Admin.
The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are upgrading. The information includes the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.

Upgrading Intelligent Customer Routing

52     Implementing Intelligent Customer Routing (ICR) May 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Implementing Intelligent Customer Routing (ICR)


 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

=========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type. For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.

Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:    Installed Version:    New Version:    Install Type:
ICRAdmin        6.0.x.0.x        6.0.3.0.x        Upgrade

Continue with installation? (Y/N):
=========================================================================

10. Type Y and press Enter to continue.
The installer checks the prerequisites required for ICR Admin and displays the
summary similar to the following.
=========================================================================
ICR Admin Prerequisite Check status
-----------------------------------

Prerequisite                        Expected result        Found
Is EPM installed?                    YES                        YES
Is EPM Version supported?        6.x                    6.0.3.0.x

PRESS <ENTER> TO CONTINUE:
=========================================================================

11. Press Enter to continue.
To upgrade ICR Admin, the installer must stop the Experience Portal Manager
service. Therefore, the ICR Admin installer displays the Stopping EPM
service screen to confirm stopping of the Experience Portal Manager service.

The default option is Continue.
=========================================================================
Stopping EPM service
--------------------

Installer will now proceed to stop Experience Portal Management service.

Do you want to continue?

  ->1- Continue
    2- Exit

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
=========================================================================
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12. Press Enter to continue, or type 2 and press Enter to exit the installer.
The system displays the Pre-Installation Summary screen with the summary
similar to the following:
=========================================================================

Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
    /opt/Avaya/ICR

Product Features:
    ICRAdmin

Disk Space Information (for Installation Target):
    Required:  40,492,141 bytes
    Available: 1,035,722,752 bytes

PRESS <ENTER> TO CONTINUE:
=========================================================================

13. Press Enter to continue.
The installer starts upgrading ICR Admin.

While upgrading ICR Admin, the ICR Admin installer displays the Starting EPM
service screen to confirm the start of the Experience Portal Manager service.

=========================================================================
Starting EPM service
--------------------

Installer will now proceed to start EPM and dependent services. This 
operation will take some time.

ICRAdmin logs will be created at

/opt/Avaya/ICR/ICRAdmin/logs/ICRAdmin_InstallLog.log and
/opt/Avaya/ICR/ICRAdmin/logs/icr_install_script.log.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, the installer creates the install logs of ICR Admin in the
ICRAdmin_InstallLog.log and admin_install_script.log files
located in the $AVAYA_ICRADMIN_HOME/logs directory. After upgrading ICR
Admin, check the log files for any errors.

14. Press Enter to continue.
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The installer completes upgrading ICR Admin and displays a message to confirm
the successful upgrade.

15. Press Enter to exit the installer.

Next steps
Verify that the Experience Portal Manager service is running:

service vpms status

Upgrading ICR CCA
Before you begin
Check the prerequisites in Prerequisites for upgrading ICR on page 49.

Procedure

1. Mount the ICR installation media on the system where ICR CCA is installed.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin, and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
The system displays the message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y, and press Enter to accept the license agreement.

6. On the Choose Install Path screen, enter the path where you installed ICR
CCA and press Enter.
By default, the installer displays the path as: /opt/Avaya/ICR.

 Note:
Before upgrading ICR CCA, the installer checks if the specified path matches the
path set in the $AVAYA_ICRCCA_HOME environment variable. If the path does
not match, the installer displays the Install Path Mismatch screen and
prompts the user to exit the installer and run the installer again with the correct
path.

=========================================================================
Install Path Mismatch
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---------------------

Installer has found a mismatch in chosen path versus installed path. ICR
component(s) cannot be upgraded to a new location.

If you have previously installed ICR components on separate location please
upgrade each component individually at installed location:

Component:        Installed At:                        New Location:
ICRCCA            /opt/Avaya/ICRCCA/ICRCCA        /opt/Avaya/ICR/ICRCCA

PRESS <ENTER> TO EXIT THE INSTALLER:
=========================================================================

7. On the Choose Product Features screen, the system displays the message:
Please choose the Features to be installed by this
installer.

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.

• To go back to the previous page, type back and press Enter.

• To select or clear a feature, enter the feature number separated by
comma.

• To cancel the installation at any time, type quit and press Enter.

8. Type 2, and press Enter to select ICR CCA .
The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are upgrading. The information includes the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.

 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

=========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type. For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.

Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:        Installed Version:        New Version:        Install Type:
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ICRCCA            6.0.x.0.x                    6.0.3.0.x            Upgrade

Continue with installation? (Y/N):
=========================================================================

10. Type Y, and press Enter to continue.
The installer checks the prerequisites required for ICR CCA and displays the
summary similar to the following:
=========================================================================
ICR CCA/ICR Core Prerequisite Check status
------------------------------------------

Prerequisite        Expected result            Found
OS & Version:        AVAYA Linux/RHEL6.x        Red Hat Enterprise Linux  6.0
Memory:                4 GB                            4.021 GB

PRESS <ENTER> TO CONTINUE:
=========================================================================

11. Press Enter to continue.
The system displays the Pre-Installation Summary screen with the summary
similar to the following:
=========================================================================
Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
    /opt/Avaya/ICR

Product Features:
    ICRCCA

Disk Space Information (for Installation Target):
    Required:  275,603,020 bytes
    Available: 1,929,621,504 bytes

PRESS ENTER TO CONTINUE:
=========================================================================

12. Press Enter to continue.
The installer starts upgrading ICR CCA.

While upgrading ICR CCA, the ICR CCA installer displays the Starting ICRCCA
service screen to confirm the start of the ICR CCA service.

=========================================================================
Starting ICRCCA service...
--------------------------

Installer will now proceed to start ICRCCA and dependent services. This 
operation will take some time.

ICRCCA logs will be created at

/opt/Avaya/ICR/ICRCCA/logs/ICRCCA_InstallLog.log and
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/opt/Avaya/ICR/ICRCCA/logs/cca_install_script.log.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, the installer creates the install logs of ICR CCA in the
ICRCCA_InstallLog.log and cca_install_script.log files located in
the $AVAYA_ICRCCA_HOME/logs directory. After upgrading ICR CCA, check
the log files for any errors.

13. Press Enter to continue.
The installer upgrades ICR CCA and displays a message to confirm the successful
upgrade.

14. Press Enter to exit the installer.

Next steps

1. Verify that the ICR CCA service is running:

service icrcca status
2. Fetch the updated security certificate from the primary Experience Portal Manager

system on the ICR CCA system.

You must fetch the updated security certificate if you change the system certificate
during the primary Avaya Aura® Experience Portal 6.0 upgrade. For more
information about managing the security certificate on the ICR CCA system, see
Administrating Intelligent Customer Routing.

Upgrading ICR Core
Before you begin
Check the prerequisites mentioned in Prerequisites for upgrading ICR on page 49.

About this task
If the configuration of ICR has multiple Core servers with Terracotta server in high availability
mode, upgrade ICR Core in one of the following ways:

• Upgrade ICR Core on all the passive Terracotta servers first and after that upgrade on
the active Terracotta server.

Check the instances of active and passive Terracotta servers.

a. Log in to the ICR Core system on which you want to check the active and
passive roles of the running Terracotta server.
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b. Go to the $AVAYA_ICRCORE_HOME/terracotta-server/bin/
directory.

c. Run the command: ./server-stat.sh.

The system displays the result similar to the following:
===========================================================
localhost.health: OK
localhost.role: ACTIVE
localhost.state: ACTIVE-COORDINATOR
localhost.jmxport: 9520
===========================================================

The localhost.role value shows the role of the Terracotta server.
• Stop the following ICR Core services that are running and after that upgrade ICR Core

on a system one after another.

service icrcore stop

service terracottaSrv stop

service icrwebservice stop

Procedure

1. Mount the ICR installation media on the system where ICR Core is installed.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin, and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
The system displays the message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y, and press Enter to accept the license agreement.

6. On the Choose Install Path screen, enter the path where you installed ICR
Core and press Enter.
By default, the installer displays the path as: /opt/Avaya/ICR.

 Note:
Before upgrading ICR Core, the installer checks if the specified path matches the
path set in the $AVAYA_ICRCORE_HOME environment variable. If the path
does not match, the installer displays the Install Path Mismatch screen
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and prompts the user to exit the installer and run the installer again with the
correct path.

=========================================================================
Install Path Mismatch
---------------------

Installer has found a mismatch in chosen path versus installed path. ICR 
component(s) cannot be upgraded to a new location.

If you have previously installed ICR components on separate location 
please upgrade each component individually at installed location:

Component:        Installed At:                            New Location:
ICRCORE            /opt/Avaya/ICRCORE/ICRCORE        /opt/Avaya/ICR/ICRCORE

PRESS <ENTER> TO EXIT THE INSTALLER:
=========================================================================

7. On the Choose Product Features screen, the system displays the message:
Please choose the Features to be installed by this
installer.

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.

• To go back to the previous page, type back and press Enter.

• To select or clear a feature, enter the feature number separated by a
comma.

• To cancel the installation at any time, type quit and press Enter.

8. Type 3, and press Enter to select ICR Core .
The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are upgrading. The information includes the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.

 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

=========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type.For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.
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Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:        Installed Version:        New Version:        Install Type:
ICRCore            6.0.x.0.x                    6.0.3.0.x            Upgrade

Continue with installation? (Y/N):
=========================================================================

10. Type Y, and press Enter to continue.
The installer checks the prerequisites required for ICR Core and displays the
summary similar to the following:
=========================================================================
ICR CCA/ICR Core Prerequisite Check status
------------------------------------------

Prerequisite        Expected result            Found
OS & Version:        AVAYA Linux/RHEL6.x        Red Hat Enterprise Linux  6.0
Memory:                4 GB                            4.021 GB

PRESS <ENTER> TO CONTINUE:
=========================================================================

11. Press Enter to continue.
The system displays the Pre-Installation Summary screen with the summary
similar to the following:
=========================================================================
Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
    /opt/Avaya/ICR

Product Features:
    ICRCore

Disk Space Information (for Installation Target):
    Required:  427,953,696 bytes
    Available: 2,074,517,504 bytes

PRESS ENTER TO CONTINUE:
=========================================================================

12. Press Enter to continue.
The installer starts upgrading ICR Core. While upgrading ICR Core, the ICR Core
installer displays the Starting ICRCore service screen to confirm the start of
the ICR Core service.
=========================================================================
Starting ICRCore service...
---------------------------

Installer will now proceed to start ICRCore and dependent services. This 
operation will take some time.
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ICRCore logs will be created at

/opt/Avaya/ICR/ICRCore/tomcat/logs folder.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, the installer creates the install logs of ICR Core in the
ICRCore_InstallLog.log file located in the $AVAYA_ICRCORE_HOME
directory. After upgrading ICR Core, check the log files for any errors.

13. Press Enter to continue.
The installer upgrades ICR Core and displays a message to confirm the successful
upgrade.

14. Press Enter to exit the installer.

Next steps

1. Verify that the httpd service is configured for an auto start.

Enter the following command to check the auto start status of the httpd service:

chkconfig httpd – –list
Command output:
httpd      0:off   1:off   2:on    3:on    4:on    5:on    6:off

In the command output, check that the levels 2 to 5 display the status as on.

If the status for the levels 2 to 5 is off, configure the httpd service for auto start
using the following command:

chkconfig httpd on
2. Fetch the updated security certificate from the primary Experience Portal Manager

system on the ICR Core system.

You must fetch the updated security certificate if you change the system certificate
during the primary Avaya Aura® Experience Portal 6.0 upgrade. For more
information on managing the security certificate on the ICR Core system, see
Administrating Intelligent Customer Routing.

3. If you change the system certificate while upgrading the auxiliary Avaya Aura®

Experience Portal 6.0 on which ICR Core is installed:

• Update the security certificate for the ICR Core.
• Import the security certificate on the primary Experience Portal Manager

system.
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• Import the updated security certificate from the auxiliary Experience Portal
Manager system to the Application server.

For more information on managing the security certificate for ICR Core and primary
Experience Portal Manager system, see Administrating Intelligent Customer
Routing. For more information on importing the security certificate on the Application
server, see Importing ICR Core certificate on the application server on page 109.

4. Reboot the system and verify that the ICR Core services are running.

service icrcore status
service terracottaSrv status
service icrwebservice status
service httpd status

5. Start the ICR Core BSR polling service from the ICR Manager Web page.

a. From the Experience Portal Manager main menu in the left navigation
pane, click System Management > ICR Manager.

b. On the ICR Manager Web page, select the ICR Core server.
c. In the Service Commands area, click Start.

Upgrading ICR on a single system
About this task
To upgrade ICR on a single system, upgrade the following ICR components installed on a
single system:

1. ICR Admin
2. ICR CCA
3. ICR Core

The installer upgrades all the ICR components in the given order.

Procedure

1. Mount the ICR installation media on the system where you installed all the three
ICR components.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Type ./install_icr.bin, and press Enter to run the installer.

3. On the Introduction screen, press Enter.

4. On the License screen, press Enter.
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The system displays the message: Do you accept the terms of this
license agreement?

 Note:
Press Enter several times to view the complete license page.

5. Type Y, and press Enter to accept the license agreement.

6. On the Choose Install Directory screen, enter the path where you installed
all the ICR components.
By default, the installer displays the path as: /opt/Avaya/ICR.

 Note:

• Before upgrading the ICR components, the installer checks if the specified
path matches the path set in the $AVAYA_ICRADMIN_HOME,
$AVAYA_ICRCCA_HOME, $AVAYA_ICRCORE_HOME environment
variables. If the path does not match, the installer displays the Install
Path Mismatch screen and prompts you to exit the installer and run the
installer again with the correct path.

• If you installed the ICR components at different locations, you must
separately upgrade the individual ICR components. For more information
about upgrading individual ICR components, see Upgrading ICR Admin on
page 51, Upgrading ICR CCA on page 55, Upgrading ICR Core on
page 58.

=========================================================================
Install Path Mismatch
---------------------

Installer has found a mismatch in chosen path versus installed path. ICR 
component(s) cannot be upgraded to a new location.

If you have previously installed ICR components on separate location 
please upgrade each component individually at installed location:

Component:        Installed At:                        New Location:
ICRCCA            /opt/Avaya/ICRCCA/ICRCCA        /opt/Avaya/ICR/ICRCCA

PRESS <ENTER> TO EXIT THE INSTALLER:
=========================================================================

7. Press Enter to continue.
The system displays the Choose Product Features screen with the message:
Please choose the Features to be installed by this installer

 Tip:

• By default, the system does not select any component. You can select or
clear the components by entering a choice.
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• To go back to the previous page, type back and press Enter.

• To select or clear a feature, enter the feature number separated by a
comma.

• To cancel the installation, type quit and press Enter.

8. Type 1,2,3, and press Enter to select ICR Admin, ICR CCA, and ICR Core
components.
The system displays [X] besides the selected feature name.

9. Press Enter to continue.
The system displays the Version Confirmation screen with the information
about the component that you are upgrading. The information includes the name of
the component, the component version if the component is already installed, the
new version of the component, and the installation type.

 Note:
When you install the ICR component, the Install Type column displays the
installation type as Full Install. But, when you upgrade the ICR component, the
Install Type column displays the installation type as Upgrade.

=========================================================================
Version Confirmation
--------------------

For the components to be installed, confirm the version numbers and the 
install type. For upgrades, most data and configuration will be preserved. 
For full installs, however, existing data and configuration will be 
overwritten.

Please proceed to accept, or type "back" to return to the previous dialog 
to modify which components to install.

Component:        Installed Version:        New Version:        Install Type:
ICRAdmin            6.0.x.0.x                    6.0.3.0.x            Upgrade
ICRCCA            6.0.x.0.x                    6.0.3.0.x            Upgrade
ICRCore            6.0.x.0.x                    6.0.3.0.x            Upgrade

Continue with installation? (Y/N):
=========================================================================

10. Type Y, and press Enter to continue.
The installer checks the prerequisites required for ICR Admin and displays the
summary similar to the following:
=========================================================================
ICR Admin Prerequisite Check status
-----------------------------------

Prerequisite                            Expected result        Found
Is EPM installed?                        YES                        YES
Is EPM Version supported?            6.x                        6.0.3.0.x

PRESS <ENTER> TO CONTINUE:
=========================================================================
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11. Press Enter to continue.
To upgrade ICR Admin, the installer must stop the Experience Portal Manager
service. Therefore, the installer displays the Stopping EPM service screen with
the message to confirm stopping of the Experience Portal Manager service.

The default option is Continue.
=========================================================================
Stopping EPM service
--------------------

Installer will now proceed to stop Experience Portal Management service.

Do you want to continue?

  ->1- Continue
    2- Exit

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
=========================================================================

12. Press Enter to continue, or type 2 and press Enter to exit the installer.
Before upgrading ICR Core and ICR CCA, the installer checks the prerequisites and
displays the summary similar to the following:
=========================================================================
ICR CCA/ICR Core Prerequisite Check status
------------------------------------------

Prerequisite        Expected result            Found
OS & Version:        AVAYA Linux/RHEL6.x        Red Hat Enterprise Linux  6.0
Memory:                4 GB                            4.152 GB

PRESS <ENTER> TO CONTINUE:
=========================================================================

13. Press Enter to continue.
The system displays the Pre-Installation Summary screen, which displays
the summary similar to the following:
=========================================================================
Pre-Installation Summary
------------------------

Please Review the Following Before Continuing:

Product Name:
    ICR

Install Folder:
    /opt/Avaya/ICR

Product Features:
    ICRAdmin,
    ICRCCA,
    ICRCore

Disk Space Information (for Installation Target):
    Required:  731,811,129 bytes
    Available: 2,039,353,344 bytes
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PRESS ENTER TO CONTINUE:
=========================================================================

14. Press Enter to continue.
The installer starts upgrading the ICR components. While upgrading ICR Admin,
the installer displays the Starting EPM service screen to confirm the start of
the Experience Portal Manager service.
=========================================================================
Starting EPM service
--------------------

Installer will now proceed to start EPM and dependent services. This 
operation will take some time.

ICRAdmin logs will be created at

/opt/Avaya/ICR/ICRAdmin/logs/ICRAdmin_InstallLog.log and
/opt/Avaya/ICR/ICRAdmin/logs/icr_install_script.log.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, the installer creates the install logs of ICR Admin in the
ICRAdmin_InstallLog.log and admin_install_script.log files
located in the $AVAYA_ICRADMIN_HOME/logs directory. After upgrade, check
the log files for any errors.

15. Press Enter to continue.
The installer upgrades ICR Admin and displays a message to confirm the successful
upgrade of ICR Admin.

16. Press Enter to continue.
The installer displays the Starting ICRCCA service screen to confirm the start
of the ICR CCA service.
=========================================================================
Starting ICRCCA service...
--------------------------

Installer will now proceed to start ICRCCA and dependent services. This 
operation will take some time. 

ICRCCA logs will be created at

/opt/Avaya/ICR/ICRCCA/logs/ICRCCA_InstallLog.log and
/opt/Avaya/ICR/ICRCCA/logs/cca_install_script.log.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================
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 Note:
By default, the installer creates the install logs of ICR CCA in the
ICRCCA_InstallLog.log and cca_install_script.log files located in
the $AVAYA_ICRCCA_HOME/logs directory. After upgrade, check the log files
for any errors.

17. Press Enter to continue.
The installer upgrades ICR CCA and displays a message to confirm the successful
upgrade of ICR CCA.

18. Press Enter to continue.
The installer displays the Starting ICRCore service screen to confirm the
start of the ICR Core service.
=========================================================================
Starting ICRCore service...
---------------------------

Installer will now proceed to start ICRCore and dependent services. This 
operation will take some time.

ICRCore logs will be created at

/opt/Avaya/ICR/ICRCore/tomcat/logs folder.

Please check the same for any errors after installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

 Note:
By default, the installer creates the install logs of ICR Core in the
ICRCore_InstallLog.log file located in the $AVAYA_ICRCORE_HOME
directory. After upgrade, check the log files for any errors.

19. Press Enter to continue.
The installer upgrades ICR Core and displays a message to confirm the successful
upgrade of ICR Core.

20. Press Enter to exit the installer.

Next steps

Reboot the system where you upgraded the ICR components and verify that the
following services are running:

• Experience Portal Manager service:

service vpms status
• ICR CCA service:
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service icrcca status
• ICR Core services:

service icrcore status
service terracottaSrv status
service icrwebservice status
service httpd status

Upgrading ICR using silent installer
Procedure

1. Mount the ICR installation media on a system where you want to upgrade the ICR
components.
For information about mounting the installation media, see Mounting the ICR
media on page 145.

2. Copy the icr_silent_install.properties file from the mount point directory
to a temporary directory on the system.

3. Edit the icr_silent_install.properties file.
The file contains the following:
========================================================================
# Replay feature output
# ---------------------
# This file was built by the Replay feature of InstallAnywhere.
# It contains variables that were set by Panels, Consoles or Custom Code.

#Choose Install Folder
#---------------------
USER_INSTALL_DIR=/opt/Avaya/ICR

#All selected ICR components will be installed under this directory
#Choose Product Features
#-----------------------
CHOSEN_INSTALL_FEATURE_LIST=ICRAdmin,ICRCCA,ICRCore
CHOSEN_INSTALL_SET=Typical

#Install
#-------
-fileOverwrite_/opt/Avaya/ICR/ICR_Uninstaller/Uninstall_ICR.lax=Yes

#VoicePortal Product Key
#-----------------------
VOICEPORTAL_PRODUCT_KEY_1=1234567890

#Inputs to install ICR Core and ICR CCA.
#VPMS IP Address
#---------------
VPMS_IP_ADDRESS_1=127.0.0.1
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#
# Set the following variables to "true" if performing an upgrade operation
#
ICRADMIN_UPGRADE_REQUIRED=false
ICRCCA_UPGRADE_REQUIRED=false
ICRCORE_UPGRADE_REQUIRED=false
========================================================================

The details of the fields present in the icr_silent_install.properties file
are:

Parameter Description

USER_INSTALL_DIR Specify the directory where the ICR
components are installed.
Use the echo command to find the
location of the ICR components that you
already installed. For example, echo
$AVAYA_ICRADMIN_HOME, echo
$AVAYA_ICRCORE_HOME, and echo
$AVAYA_ICRCCA_HOME.
From the output of the echo command,
copy the installed location of the ICR
component, excluding the ICR
component directory name displayed at
the end. Use the copied location as the
value for the USER_INSTALL_DIR
parameter.
For example,
Command: echo
$AVAYA_ICRADMIN_HOME
Command output: /opt/Avaya/ICR/
ICAAdmin
From the command output, exclude the
ICR component directory name, that is
ICRAdmin and use the remaining part
as the upgrade location.

 Note:
If you installed the ICR components in
different directories, for example ICR
Admin installed at /opt/
Avaya/ICR and ICR CCA installed
at /opt/Avaya/ICR2, you must
separately upgrade those ICR
components.

CHOSEN_INSTALL_FEATURE_LIS
T

Specify the ICR components that you
want to upgrade and remove the other
ICR components.
The default feature list is:
ICRAdmin,ICRCCA,ICRCore.
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Parameter Description

CHOSEN_INSTALL_SET Specify the installation type.
The default value is Typical.

 Note:
Do not change the default value.

VOICEPORTAL_PRODUCT_KEY_
1

Specify the Product ID of the Avaya Aura®

Experience Portal system.

VPMS_IP_ADDRESS_1 Specify the IP address of the primary
Experience Portal Manager system.

ICRADMIN_UPGRADE_REQUIRE
D

Set the value of this parameter to true
if you want to upgrade ICR Admin.

ICRCCA_UPGRADE_REQUIRED Set the value of this parameter to true
if you want to upgrade ICR CCA.

ICRCORE_UPGRADE_REQUIRED Set the value of this parameter to true
if you want to upgrade ICR Core.

 Note:
The installer installs ICR using the values from the
icr_silent_install.properties file.

4. Save the changes and close the file.

5. Type ./install_icr.bin -i silent -f
<Location_of_the_icr_silent_install.properties_file>/
icr_silent_install.properties and press Enter:
where,

• i is the mode of upgrade.

• f is the file location of the icr_silent_install.properties file.

The installer upgrades the specified ICR component.

 Note:

• The system does not display the upgrade progress. Therefore, wait until the
upgrade process completes.

• If you upgrade the ICR components using the silent installer, the uninstaller
uninstalls all the ICR components silently.

Next steps

1. Verify that the httpd service is configured for an auto start.

Upgrading ICR using silent installer
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Enter the following command to check the auto start status of the httpd service:

chkconfig httpd – –list
Command output:
httpd      0:off   1:off   2:on    3:on    4:on    5:on    6:off

In the command output, check that the levels 2 to 5 display the status as on.

If the status for the levels 2 to 5 is off, configure the httpd service for auto start using
the following command:

chkconfig httpd on
2. Reboot the system where you upgraded the ICR components and verify that the

following services are running:

• Experience Portal Manager service:

service vpms status
• ICR CCA service:

service icrcca status
• ICR Core services:

service icrcore status
service terracottaSrv status
service icrwebservice status
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Chapter 5: Configuring Avaya Aura®
Communication Manager

Log in to the CM server
Log in to the CM server and select the SAT terminal type as SUNT.

For details on connecting to CM server using Putty, refer to Administering Avaya Aura®

Communication Manager document from the Support site at http://support.avaya.com.

Adding Session Manager IP Address
Configure Communication Manager to communicate with Session Manager. Add the Session
Manager IP address to Communication Manager node-names list.

Procedure

1. Log in to the Communication Manager system and select the SAT terminal type as
SUNT.

2. On the SAT session, in the Command: prompt, type change node-names ip and
press Enter.
The system displays the IP NODE Names screen.

3. Use the up or down arrow key and scroll to a blank line.

4. In the Name column, type the name of the Session Manager server.

5. In the IP address field, type the IP address of the Session Manager Security
Module.

 Note:
Do not use the management IP address in the IP address field.

The IP NODE Names screen displays the information similar to the following:
=========================================================================
======
change node-names ip                                            Page   1 of   2
IP NODE NAMES
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Name                IP Address
ASM_Server_Name     192.168.1.11
default             0.0.0.0
procr               192.168.1.12
procr6              ::

( 5  of 5  administered node-names were displayed )
Use 'list node-names' command to see all the administered node-names
Use 'change node-names ip xxx' to change a node-name 'xxx' or add a node-
name
=========================================================================
=====

6. Press F3 key to save the changes.

Creating a signaling-group
Configure signaling–group on Communication Manager.

Procedure

1. On the SAT session, in the Command: terminal, type add signaling-group n
and press Enter.
The system displays the SIGNALING GROUP screen.

The n is the signaling-group number.

2. Use the up or down arrow key and scroll to the Group Type option.

3. In the Group Type option, type SIP and press tab key.
The SIGNALING GROUP screen displays the information similar to the following:
=========================================================================
===
add signaling-group n                                        Page   1 of   1

SIGNALING GROUP

Group Number: 2       Group Type: sip
IMS Enabled? n        Transport Method: tcp
Q-SIP? n              SIP Enabled LSP? n

Enforce SIPS URI for SRTP? y
Peer Detection Enabled? y  Peer Server: Others

Near-end Node Name: procr        Far-end Node Name: ASM_SERVER_NAME
Near-end Listen Port: 5060       Far-end Listen Port: 5060
                                 Far-end Network Region:

Far-end Domain:
                                          Bypass If IP Threshold Exceeded? n
Incoming Dialog Loopbacks: eliminate      RFC 3389 Comfort Noise? n
         DTMF over IP: rtp-payload        Direct IP-IP Audio Connections? y
Session Establishment Timer(min): 3       IP Audio Hairpinning? n
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         Enable Layer 3 Test? n           Initial IP-IP Direct Media? n
H.323 Station Outgoing Direct Media? n    Alternate Route Timer(sec): 6

F1=Cancel F2=Refresh F3=Submit F4=Clr Fld F5=Help F6=Update F7=Nxt Pg 
F8=Prv Pg
=========================================================================
======

4. Update the following values:

Group Type SIP

Transport Method TLS or TCP.

 Note:
Ensure that you set the same value
for transport method while
configuring Entity link on Session
Manager

Near-end Node Name procr

 Tip:
This is the Communication Manager
node name.

Near-end Listen Port An unused port number for the near-end
listen port.

Far-end Node Name
 Tip:

This is the node name configured for
Session Manager.

Far-end Listen Port An unused port number for the far-end
listen port.

Far-end Network Region The number of the network region that
is assigned to the far-end of the
signaling group. The region is used to
obtain the codec set used for
negotiation of trunk bearer capability.

Far-end Domain The name of the IP domain that is
assigned to the far-end of the signaling
group.

5. Press F3 key to save the changes.

Creating a signaling-group
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Creating a Trunk group
Procedure

1. On the SAT session, in the Command: terminal, type add trunk-group n and
press Enter. The n is the trunk group number. The TRUNK GROUP screen
appears.

2. Use the up or down arrow key and scroll to Group Type option. In the Group
Type option, type SIP. Press TAB key.

3. The TRUNK GROUP screen displays the information similar to the one provided
below.
add trunk-group n                                     Page   1 of  22
                        TRUNK GROUP

Group Number: 2              Group Type: sip       CDR Reports: y
Group Name: trunk to ASM     COR: 1        TN: 1        TAC: #2
Direction: two-way        Outgoing Display? n
Dial Access? n                      Night Service:
Queue Length: 0
Service Type: tie                   Auth Code? n

                                    Signaling Group: 2
                                    Number of Members: 255

4. Update the following values:

Group Type sip

Signaling Group Signaling Group

 Note:
This value must be configured with
the Signaling Group value created
previously.

Number of Members This value will be the number of ports for
this SIP connection

Service Type Tie

TAC Enter the Trunk Access Code as per dial
plan

5. Press F7 key to go to the next page. There are no changes required on screen 2.

6. Press F7 key to go to the next page. In Page 3 of 22, the following information is
displayed:
                                                    Page   3 of  22
TRUNK FEATURES
   ACA Assignment? n            Measured: none
                                   Maintenance Tests? y
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           Numbering Format: public
                                   UUI Treatment: shared
                                   Maximum Size of UUI Contents: 128
                                   Replace Restricted Numbers? n
                                   Replace Unavailable Numbers? n

                              Modify Tandem Calling Number: no
               Send UCID? y

 Show ANSWERED BY on Display? y
7. Update the following values:

UUI Treatment This value must be set to shared.

Send UCID Set to Yes

8. Press F3 key to save the changes.

Creating Hunt group

Procedure

1. On the SAT session, in the Command: terminal, type add hunt-group n and
press Enter. The n is the hunt group number. The HUNT GROUP screen
appears.
Use the up or down arrow key to scroll.

2. Update the following values:

Group Number Numeric value

Group Extension Extension of the group

ACD? Y

Vector? Y

Queue? Y

The HUNT GROUP screen displays the information similar to the one provided
below.
add hunt-group n                                  Page   1 of   4
                                HUNT GROUP

        Group Number: 1                              ACD? y

Creating Hunt group
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        Group Name: english                        Queue? y
        Group Extension: 2000                     Vector? y
        Group Type: ucd-mia
                  TN: 1
                  COR: 1               MM Early Answer? n
        Security Code:                 Local Agent Preference? n
ISDN/SIP Caller Display:

             Queue Limit: unlimited
 Calls Warning Threshold:      Port:
  Time Warning Threshold:      Port:

3. Press F7 to go to the next page.

4. Use the up or down arrow key to scroll. Type the value of the parameter skill? as
Y.
The HUNT GROUP screen displays the information similar to the one provided
below.
add hunt-group n                                     Page   2 of   4
                                HUNT GROUP

                Skill? y      Expected Call Handling Time (sec): 180
                  AAS? n        Service Level Target (% in sec): 80 in 20
                Measured: internal
   Supervisor Extension:

   Controlling Adjunct: none

      VuStats Objective:
 Timed ACW Interval (sec):
 Multiple Call Handling: none

5. Press F3 to save the changes.

Creating a Vector for polling VDN
ICR uses this vector for the Best Service Routing (BSR) polling.

Procedure

1. On the SAT session, in the Command: terminal, type change vector n and press
Enter.
The system displays the CALL VECTOR screen.

The n is the number of the vector being created.

2. Use the up or down arrow key and scroll to 01 option.

3. Type Consider and press the TAB key.
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This value is added to consider the hunt-group for agents already configured in
Communication Manager.

4. Type the required value in the skill option and press the TAB key.

5. Type the required value in the pri m adjust-by option and press the TAB key.

6. Use the up or down arrow key and scroll to 02 option.

7. Type reply-best and press Enter.

8. Use the up or down arrow key and scroll to 03 option.

9. Type stop and press Enter.
The system displays the following information:
change vector n                                        Page   1 of   6
                             CALL VECTOR

Number: 1                Name: polling vector
                                                               Lock? n
Basic? y  EAS? y  G3V4 Enhanced? y   ANI/II-Digits? y  ASAI Routing? y
Prompting? y   LAI? y G3V4 Adv Route? y  CINFO? y  BSR? y  Holidays? y
Variables? y   3.0 Enhanced? y
01 consider     skill    1    pri m adjust-by 0
02 reply-best
03 stop
04
05
06
07
08
09
10
11
12

                       Press 'Esc f 6' for Vector Editing

10. Press F3 key to save the changes.

Creating a Vector for Queuing VDN
This vector is used to queue the call.

Procedure

1. On the SAT session, in the Command: terminal, type change vector n and press
Enter. The n is the number of the vector being created for Queuing. The CALL
VECTOR screen appears.

Creating a Vector for Queuing VDN
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 Note:
You must provide a Name for the vector.

2. Use the up or down arrow key and scroll to 01 option. Type queue-to and press
the TAB key. This value is added to queue the hunt-group for agents already
configured in CM.

3. Type the required value in the skill option and press the TAB key.

4. Type the required value in the pri m adjust-by option and press the TAB key.

5. Use the up or down arrow key and scroll to 02 option. Type stop and press
Enter.

6. A screen similar to the one provided below is displayed:
change vector n                                       Page   1 of   6
                                CALL VECTOR

Number: 2                Name: Queue Vector
                                                              Lock? n
Basic? y  EAS? y  G3V4 Enhanced? y  ANI/II-Digits? y  ASAI Routing? y
Prompting? y  LAI? y  G3V4 Adv Route? y  CINFO? y  BSR? y Holidays? y
Variables? y   3.0 Enhanced? y
01 queue-to     skill 1    pri m
02 stop
03
04
05
06
07
08
09
10
11
12

                   Press 'Esc f 6' for Vector Editing
7. Press F3 key to save the changes.

 Note:
The queuing vector must not have any music or ring-back treatments setup, or
the EPM will prematurely REFER the call media path down to the Communication
Manager before an agent is ready to answer.

Creating a Polling VDN
About this task
This VDN is used as a polling VDN while configuring skill on the ICR configuration page.
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Procedure

1. On the SAT session, in the Command: terminal, type add vdn n and press
Enter. The n is the number of the VDN created. The VECTOR DIRECTORY
NUMBER screen appears.

2. Use the up or down arrow key to scroll. In the first page, provide the following
information:

• VDN name

• Vector number that this VDN will use. Set the value of this field to the value of
the Vector that was created in Creating a Vector for polling VDN on page 78.

3. The first screen of VECTOR DIRECTORY NUMBER displays the information
similar to the one provided below.
add vdn n                                            Page   1 of   3
                    VECTOR DIRECTORY NUMBER

                         Extension: n
                         Name*: polling vdn
                         Destination: Vector Number        1

                    Allow VDN Override? n
                                   COR: 1
                                   TN*: 1
                              Measured: none

        VDN of Origin Annc. Extension*:
                            1st Skill*:
                            2nd Skill*:
                            3rd Skill*:

* Follows VDN Override Rules
4. Press F7 to go to the next page.

5. Use the up or down arrow key to scroll. In the second page, provide the following
information:

• BSR Available Agent Strategy. This is used for multiple skills configured in the
VDN.

• BSR Tie Strategy. This is used in case a tie happens.

6. Set all the other options to N.

7. The second screen of VECTOR DIRECTORY NUMBER displays the information
similar to the one provided below.
add vdn n                                                Page   2 of   3
                            VECTOR DIRECTORY NUMBER

                                 AUDIX Name:
                        Return Destination*:
                    VDN Timed ACW Interval*:
                           BSR Application*:

Creating a Polling VDN
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              BSR Available Agent Strategy*: 1st-found
                          BSR Tie Strategy*: system

                    Observe on Agent Answer? n

  Send VDN as Called Ringing Name Over QSIG? n

              Display VDN for Route-To DAC*? n
            VDN Override for ASAI Messages*: no

                       BSR Local Treatment*? n

          Reporting for PC Predictive Calls? n
           Pass Prefixed CPN to VDN/Vector*? system
* Follows VDN Override Rules

8. Press F3 to save the changes.

Creating a Queue VDN
About this task
This VDN is used as a Queue VDN while configuring skill on ICR configuration page.

Procedure

1. On the SAT session, in the Command: terminal, type add vdn n and press
Enter. The n is the number of the VDN created. The VECTOR DIRECTORY
NUMBER screen appears.

2. Use the up or down arrow key to scroll. In the first page, provide the following
information:

• Queue VDN name

• Vector number that this VDN will use. Set the value of this field to the value of
the Vector that was created in Creating a Vector for Queuing VDN on
page 79.

3. The first screen of VECTOR DIRECTORY NUMBER displays the information
similar to the one provided below.
add vdn n                                                Page   1 of   3
                            VECTOR DIRECTORY NUMBER

                             Extension: n
                                 Name*: queuing vdn
                           Destination: Vector Number        1

                    Allow VDN Override? n
                                   COR: 1
                                   TN*: 1
                              Measured: none
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        VDN of Origin Annc. Extension*:
                            1st Skill*:
                            2nd Skill*:
                            3rd Skill*:

* Follows VDN Override Rules
4. Press F7 to goto the next page.

5. Use the up or down arrow key to scroll. In the second page, provide the following
information:

• BSR Available Agent Strategy. This is used for multiple skills configured in the
VDN.

• BSR Tie Strategy. This is used in case a tie happens.

6. Set all the other options to N.

7. The second screen of VECTOR DIRECTORY NUMBER displays the information
similar to the one provided below.
add vdn n                                                Page   2 of   3
                            VECTOR DIRECTORY NUMBER

                                 AUDIX Name:
                        Return Destination*:
                    VDN Timed ACW Interval*:
                           BSR Application*:
              BSR Available Agent Strategy*: 1st-found
                          BSR Tie Strategy*: system

                    Observe on Agent Answer? n

  Send VDN as Called Ringing Name Over QSIG? n

              Display VDN for Route-To DAC*? n
            VDN Override for ASAI Messages*: no

                       BSR Local Treatment*? n

          Reporting for PC Predictive Calls? n
           Pass Prefixed CPN to VDN/Vector*? system
* Follows VDN Override Rules

8. Press F3 to save the changes.

Adding the Queuing VDN to public unknown numbering
plan

You must add the Queuing VDN to the Public Unknown numbering plan of Communication
Manager so that, when responding to SIP commands associated to this VDN, Communication
Manager can send the number in the messages.

Adding the Queuing VDN to public unknown numbering plan
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Procedure

1. On the SAT session, in the Command: terminal, type change public-unknown-
numbering 0 and press Enter.
The system displays the NUMBERING - PUBLIC/UNKNOWN FORMAT screen.

2. Use the up or down arrow key to scroll.
On the first page, provide the following information:

• Ext Len
• Ext Code
• Trk Grp(s)
• Total CPN Len

The first screen of NUMBERING - PUBLIC/UNKNOWN FORMAT displays the
information similar to what is provided below.
change public-unknown-numbering 0                        Page   1 of   2
                      NUMBERING - PUBLIC/UNKNOWN FORMAT
                                           Total
Ext Ext       Trk      CPN         CPN
Len Code      Grp(s)   Prefix      Len
                                   Total Administered: 1
 5  8                              5        Maximum Entries: 240

                                  Note: If an entry applies to
                                        a SIP connection to Avaya
                                        Aura(tm) Session Manager,
                                        the resulting number must
                                        be a complete E.164 number.

3. Press F3 key to save the changes.

Adding the IP Network Region
You must define the Authoritative Domain name on the IP-network-region form.

Procedure

1. On the SAT session, in the Command: prompt, type change ip-network-
region 1 and press Enter. The IP NETWORK REGION screen appears.

2. Use the up or down arrow key to scroll. In the first page, provide the following
information:
• Define the Authoritative Domain name.

3. The first screen of IP NETWORK REGION displays the information similar to the
one provided below.
change ip-network-region 1                              Page   1 of  20
                               IP NETWORK REGION
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Region: 1
Location:         Authoritative Domain: avaya.com
Name:
MEDIA PARAMETERS             Intra-region IP-IP Direct Audio: yes
      Codec Set: 1           Inter-region IP-IP Direct Audio: yes
   UDP Port Min: 2048                     IP Audio Hairpinning? n
   UDP Port Max: 3329
DIFFSERV/TOS PARAMETERS
 Call Control PHB Value: 46
        Audio PHB Value: 46
        Video PHB Value: 26
802.1P/Q PARAMETERS
 Call Control 802.1p Priority: 6
        Audio 802.1p Priority: 6
        Video 802.1p Priority: 5   AUDIO RESOURCE RESERVATION PARAMETERS
H.323 IP ENDPOINTS                                       RSVP Enabled? n
H.323 Link Bounce Recovery? y
Idle Traffic Interval (sec): 20
Keep-Alive Interval (sec): 5
         Keep-Alive Count: 5

4. Press F3 key to save the changes.

Adding the IP codec set
You must add the IP codec set in Communication Manager to establish successful RTP path
with the customer.

Procedure

1. On the SAT session, in the Command: prompt, type change ip-codec-set n
and press Enter. The n is the ip codec set number. The IP Codec Set screen
appears.

2. Use the up or down arrow key to scroll. In the first page, provide the following
information:

• Audio Codec

• Silence Suppression

• Frames Per Packet

• Packet Size in milliseconds

3. The first screen of IP Codec Set displays the information similar to the one provided
below.
change ip-codec-set 1                                           Page   1 of   2

                          IP Codec Set

    Codec Set: 1

    Audio        Silence      Frames   Packet
    Codec        Suppression  Per Pkt  Size(ms)

Adding the IP codec set
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 1: G.729             n         2        20
 2: G.711A            n         2        20
 3: G.729A            n         2        20
 4: G.711MU           n         2        20
 5:
 6:
 7:

4. Press the F3 key to save the changes.

Configuring Avaya Aura® Communication Manager

86     Implementing Intelligent Customer Routing (ICR) May 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Implementing Intelligent Customer Routing (ICR)


Chapter 6: Configuring Avaya Aura®
Session Manager

This chapter provides Session Manager configuration for ICR. However, for more information, see
Administering Avaya Aura ® Session Manager document from the support site at http://
support.avaya.com.

Logging on to System Manager Web Console
Before you begin
Obtain a user account to log on to the System Manager Web interface. If you do not have a
user account, go to the Avaya Support website at https://support.avaya.comto create your
account.

About this task
System Manager Web Console is the main interface of Avaya Aura® System Manager. To
perform any tasks, you must log on to System Manager Web Console.

 Important:
On System Manager Web Console, do not use the back arrow on the top-left corner of the
browser to navigate to the previous page. If you click the back arrow, the system might
exhibit an inconsistent and unexpected behavior.

Procedure

1. On the Web browser, enter the System Manager URL https://<Fully
Qualified Domain Name>/SMGR.

2. In the User ID field, enter the user name.

3. In the Password field, enter the password.

4. Click Log On.
The system validates the username and password with the System Manager user
account. Depending on the validity, the system displays one of the following
screens:

• If the username and password match, the system displays the System
Manager home page with the System Manager version_number. The System
Manager home page displays the navigation menu. The menu provides access
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to shared services to perform various operations that System Manager
supports. The tasks you can perform depends on your user role.

• If the username and password does not match, System Manager displays an
error message and prompts you to re-enter the user name and password.

Adding a SIP domain 
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > SIP Domains

• For System Manager 6.x, select Routing > Domains

3. On the Domain Management page, click New.

4. Enter the domain name and notes for the new domain or sub-domain.

5. Select sip as the domain type from the drop-down list.

6. Click Commit.

Adding SIP Entities

Adding SIP Entity for SIP Gateway or Session Border Controller
(SBC)

Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > SIP Entities
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On the SIP Entities Details page, click New to add the SIP Entity
details.

• For System Manager 6.x, select Routing > SIP Entities

On the SIP Entities Details page, click New to add the SIP Entity
details.

3. On the Details page, add the SIP Entities information.

Parameter Value

Name Name of the SIP Gateway or Session
Border Controller.
This name must be unique and can
have between 3 and 64 characters.

FQDN or IP Address IP address of the SIP Gateway or
Session Border Controller configured in
the signaling–group on CM.

TYPE Gateway

Notes Additional notes about the SIP entity.

Location SIP entity location. Select from
previously defined locations.

Time Zone Default time zone to be used for the
entity.

SIP Link Monitoring Select the process for SIP Link
monitoring.

4. Click Commit to save the configurations.

Adding SIP Entities for Communication Manager
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > SIP Entities

On the SIP Entities Details page, click New to add the SIP Entities
information for Communication Manager.

• For System Manager 6.x, select Routing > SIP Entities

Adding SIP Entities
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On the SIP Entities Details page, click New to add the SIP Entities
information for Communication Manager.

3. On the Details page, add the SIP Entities information.

Parameter Value

Name Name of the CM server.
This name must be unique and can
have between 3 and 64 characters.

FQDN or IP Address IP address of the CLAN/Procr
configured in the signaling–group on
CM

TYPE CM

Notes Additional notes about the SIP entity.

Location SIP entity location. Select from
previously defined locations.

Time Zone Default time zone to be used for the
entity.

SIP Link Monitoring Select the process for SIP Link
monitoring.

4. Click Commit to save the configurations.
Perform these steps to create SIP Entities for all the required CM servers.

Adding SIP Entity for Avaya Aura® Experience Portal
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > SIP Entities

On the SIP Entities Details page, click New to add the SIP Entities
information for Avaya Aura® Experience Portal.

• For System Manager 6.x, select Routing > SIP Entities

On the SIP Entities Details page, click New to add the SIP Entities
information for Avaya Aura® Experience Portal.

3. On the Details page, add the SIP Entities information.
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Parameter Value

Name Name of the Avaya Aura® Experience
Portal server.
This name must be unique and can
have between 3 and 64 characters.

FQDN or IP Address IP address of Media Processing
Platform. If you have multiple Media
Processing Platform then add all Media
Processing Platform with a single
FQDN under Local Host Name
configured.

TYPE Avaya Aura® Experience Portal

Notes Additional notes about the SIP entity.

Location SIP entity location. Select from
previously defined locations.

Time Zone Default time zone to be used for the
entity.

SIP Link Monitoring Select the process for SIP Link
monitoring.

4. Click Commit to save the configurations.

Adding SIP Entities for ICR Core
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, click Network Routing Policy > SIP Entities

On the SIP Entities Details page, click New to add the SIP Entities
information for ICR Core.

• For System Manager 6.x, click Routing > SIP Entities

On the SIP Entities Details page, click New to add the SIP Entities
information for ICR Core.

3. On the Details page, add the SIP Entities information.

Adding SIP Entities
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Parameter Value

Name Name of the ICR Core Server.
This name must be unique and can
have between 3 and 64 characters.

FQDN or IP Address IP address of ICR system. If you have
multiple ICR then add all the ICR
systems with a single FQDN under the
configured Local Host Name.

TYPE The SIP entity type.
Click Other.

Notes Additional notes about the SIP entity.

Location SIP entity location.
Select from the previously defined
locations.

Time Zone Default time zone to be used for the
entity.

Credential name Enter a regular expression string in the
Credential name.
The Credential name is used for TLS
connection validation. You can validate
the TLS connection by searching
Credential name in the SIP entity
identity certificate.

SIP Link Monitoring Select the process for SIP Link
monitoring.

4. Click Commit to save the configurations.

Adding SIP Entity links

Adding SIP Entity Link for SIP Gateway or SBC
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

Configuring Avaya Aura® Session Manager

92     Implementing Intelligent Customer Routing (ICR) May 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Implementing Intelligent Customer Routing (ICR)


• For System Manager 5.2, select Network Routing Policy > Entity Links

On the Entity Links page, click New to add the Entity Links
information.

• For System Manager 6.x, select Routing > Entity Links

On the Entity Links page, click New to add the Entity Links
information.

3. On the Links page, add the SIP Entity Links information.

Name Description

Name Name of the SIP Entity Link for SIP
gateway or SBC.
This name must be unique and can
have between 3 and 64 characters.

SIP Entity 1 Select a SIP entity from the drop-down
list. This entity must always be a
Session Manager instance.

Protocol Protocol to be used for the entity link.

Port Port to be used for SIP entity 1.

SIP Entity 2 This entity is created for SIP gateway
or SBC

Port Port to be used for SIP gateway or
SBC.

Trusted Specifies that the link between the two
SIP entities is trusted. Select the Check
box

Notes Any details or notes that you wish to
add.

4. Click Commit to save the configurations.

Adding SIP Entity Link for Communication Manager
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > Entity Links

Adding SIP Entity links
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On the Entity Links page, click New to add the Entity Links information
for Communication Manager.

• For System Manager 6.x, select Routing > Entity Links

On the Entity Links page, click New to add the Entity Links information
for Communication Manager.

3. On the Links page, add the SIP Entity Links information.

Name Description

Name Name of the SIP Entity Link for
Communication Manager server.
This name must be unique and can
have between 3 and 64 characters.

SIP Entity 1 Select a SIP entity from the drop-down
list. This entity must always be a
Session Manager instance.

Protocol Protocol to be used for the entity link.

Port Port to be used for SIP entity 1.

SIP Entity 2 Select a SIP entity from the field. This
is the entity created for CM.

Port Enter the port for Communication
Manager.

Trusted Specifies that the link between the two
SIP entities is trusted. Select this
option.

Notes Any details or notes that you wish to
add.

4. Click Commit to save the configurations.

Adding SIP Entity Link for Avaya Aura® Experience Portal
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > Entity Links.
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On the Entity Links page, click New to add the Entity Links information
for Avaya Aura® Experience Portal.

• For System Manager 6.x, select Routing > Entity Links.

On the Entity Links page, click New to add the Entity Links information
for Avaya Aura® Experience Portal.

3. On the Links page, add the SIP Entity Links information.

Name Description

Name Name of the SIP Entity Link for Avaya
Aura® Experience Portal server.
This name must be unique and can
have between 3 and 64 characters.

SIP Entity 1 Select a SIP entity from the drop-down
list. This entity must always be a
Session Manager instance.

Protocol Protocol to be used for the entity link.

Port Port to be used for SIP entity 1.

SIP Entity 2 Select a SIP entity from the field. This
is the entity created for MPP.

Port Port to be used for SIP entity 2.

Trusted Specifies that the link between the two
SIP entities is trusted. Select this
option.

Notes Any details or notes that you wish to
add.

4. Click Commit to save the configurations.

Adding SIP Entity Link for ICR Core Server
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > Entity Links.

On the Entity Links page, click New to add the Entity Links information
for ICR server node.

Adding SIP Entity links
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• For System Manager 6.x, select Routing > Entity Links.

On the Entity Links page, click New to add the Entity Links information
for ICR server node.

3. On the Links page, add the SIP Entity Links information.

Name Description

Name Name of the SIP Entity Link for ICR
Core server.
This name must be unique and can
have between 3 and 64 characters.

SIP Entity 1 Select a SIP entity from the drop-down
list. This entity must always be a
Session Manager instance.

Protocol Protocol to be used for the entity link.

Port Port to be used for SIP entity 1.

SIP Entity 2 Select a SIP entity from the field. This
is the entity created for ICR Core server

Port Port to be used for SIP entity 2.

Trusted Specifies that the link between the two
SIP entities is trusted. Select this
option.

Notes Any details or notes that you wish to
add.

4. Click Commit to save the configurations.

Defining Policies and Time of Day

Adding Routing Policy for Communication Manager
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > Routing Policies
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• For System Manager 6.x, select Routing > Policies

3. On the Routing Policies page, click New to add the Routing Policy information for
Communication Manager.

4. On the Routing Policy Details page, under General, provide the value for Name
field. You can also provide generic information for reference in the Notes field.

5. Under SIP Entity as Destination, click Select.

6. From the list of SIP Entities, select the Communication Manager SIP Entity.

7. Under Time of Day, click Add.

8. From the Time Ranges List page, select the required Time Range.

9. Click Select.
The selected Time Range displays on the Routing Policy Details page.

10. Click Commit to save the configuration.

Adding Routing Policy for Avaya Aura® Experience Portal
Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > Routing Policies

• For System Manager 6.x, select Routing > Policies

3. On the Routing Policies page, click New to add the Routing Policy information for
Avaya Aura® Experience Portal.

4. On the Routing Policy Details page, under General, provide the value for Name
field. You can also provide generic information for reference in the Notes field.

5. Under SIP Entity as Destination, click Select.

6. From the list of SIP Entities, select the Avaya Aura® Experience Portal SIP Entity.

7. Under Time of Day, click Add.

8. From the Time Ranges List page, select the required Time Range.

9. Click Select.
The selected Time Range displays on the Routing Policy Details page.

10. Click Commit to save the configuration.

Defining Policies and Time of Day
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Dial Patterns

Adding dial plan for Avaya Aura® Experience Portal and
Communication Manager

About this task

 Note:
You must configure a minimum of two dial patterns.

• Pattern to route calls to Experience Portal Manager for incoming calls to Avaya Aura®

Experience Portal.
• Pattern to route calls to agents and for polling/queuing VDN’s to Communication

Manager.

Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select Network Routing Policy > Dial Patterns

• For System Manager 6.x, select Routing > Dial Patterns

3. On the Dial Patterns page, click New to add a new Dial Pattern for Avaya Aura®

Experience Portal.
Under General, provide the value for the fields provided in the table.

Name Description

Pattern Dial pattern to match. The pattern can
have between 1 and 36 characters. Roll
over the field for the valid pattern.

Min Minimum number of digits to be
matched.

Max Maximum number of digits to be
matched.

SIP Domain Domain for which you want to restrict
the dial pattern.

Notes Other details that you wish to add.

Configuring Avaya Aura® Session Manager

98     Implementing Intelligent Customer Routing (ICR) May 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Implementing Intelligent Customer Routing (ICR)


4. Under Originating Locations and Routing Policies, click Add.

5. Under Originating Location, select the originating location.

6. Under Routing Policies, select the routing policy.

7. Click Select.

8. Click Commit to save the configuration.

Adding ICR user on System Manager
About this task
Configure the User Name and Password for the ICR Core Server. If ICR Core server is not
marked as trusted while configuring Entity Link between ICR Core server and SM then the
created SIP user is used during BSR polling. By default, the SIP user name is avaya and
password avaya123. This information is stored in ../ICR/ICRCore/tomcat/conf/
icrcore.properties file. Administrator can configure another SIP user and edit the
property file.

Procedure

1. Log in to the System Manager Web interface with the Administration user role.

2. From the System Manager main menu:

• For System Manager 5.2, select User Management > User Management .

• For System Manager 6.x, select Users > Manage Users.

3. On the User Management page, under Users, click New.

4. Under General, provide the following information.

Name Description
Last Name avaya

First Name avaya

Description

User Type Select as Communication User

5. Under Identity, provide the following information.

Name Description
Login Name Enter login name as avaya

Adding ICR user on System Manager
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Name Description
Authentication Type Select as Basic

SMGR Login Password Enter the password as avaya123

Password avaya123

Confirm Password avaya123

Shared Communication Profile
Password

avaya123

Confirm Password avaya123

6. Under Communication Profilesection, under Communication Address, click New.
Add the user name as avaya.

7. In the Type field, select Avaya SIP.

8. Add appropriate values to set Fully Qualified Address.

9. Click Add.

10. In the Communication Profile section, select Session Manager Profile.

11. From the field, select the Primary Session Manager and Secondary Session
Manager (if required).

12. Click Commit to save the user's information.
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Chapter 7: Configuring Avaya Aura®
Experience Portal

About configuring Avaya Aura® Experience Portal
ICR Core reads the SIP proxy server configuration from the VoIP Connections Web page of
Avaya Aura® Experience Portal. ICR is a managed application of Avaya Aura® Experience
Portal. Therefore, Media Processing Platform (MPP) and Speech servers are already
configured on Avaya Aura® Experience Portal. To check the configuring details of the MPP
servers and the Speech servers, see the Avaya Aura® Experience Portal documentation.

Related topics:
Adding a SIP connection for Session Manager on page 101

Adding a SIP connection for Session Manager
Procedure

1. Log on to an Experience Portal Manager Web page using an account with the
Administration or ICR Administration role.

2. From the Experience Portal Managermain menu in the left navigation pane, click
System Configuration > VoIP Connections.

3. On the VoIP Connections page, click the SIP tab.

4. Click Add.

5. On the Add SIP Connection page, enter the values in the following fields.

Field Description

Name Enter appropriate name for SIP
connection.

Enable Default value is Yes.

Proxy Transport TCP or TLS as per configuration.
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Field Description

Proxy Services Address Enter the IP address of Security module
of Session Manager.

DNS SRV Domain Enter the domain name of the DNS
server. For example, abc.com.

SIP Domain Enter the domain of Session Manager.

Maximum Simultaneous Calls The maximum number of calls that this
trunk can handle at one time.

6. Click Save.

Configuring Avaya Aura® Experience Portal
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Chapter 8: Installing ICR Pluggable Data
Connector

ICR Pluggable Data Connector
ICR Pluggable Data Connector (PDC) is a connector between Self Service Application (SSA)
and ICR Core. ICR PDC is built to integrate ICR into Orchestration Designer. ICR PDC is a
generic connector, which an application developer can use without knowledge of call centers
and ICR Core. ICR PDC provides a SIP URI, which is the routing destination for a skill.

ICR PDC also does the load balancing of skill selection requests that arrives across multiple
ICR Cores.

Prerequisite
Orchestration Designer to create and build applications.

If you are installing Orchestration Designer for the first time, see the Orchestration Designer
documentation from the Avaya support site at http://support.avaya.com.

Copying ICR PDC to the plugins folder in Orchestration
Designer

Procedure

Copy com.avaya.icr.PDC.ui.jar file from ICRPDC folder on the CD to
<Eclipse_Home>/plugins folder.

 Note:
Close the Eclipse application before copying the file to the plugins folder.
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Importing sample applications in Eclipse
Procedure

1. Copy the SampleApps.zip file from the ISO image of ICR to a temporary
location.

2. Unzip the SampleApps.zip file in a directory to extract the sample applications.
After you unzip the SampleApps.zip file, the directory contains the following
sample applications:

Sample Application
Name

Description

SSA This folder contains sample application for Sample
Self Service Application.

WTA This folder contains two sample Wait Treatment
Applications.

• WTAUpdateAAI: Demonstrates how to collect
additional information from a caller and pass that
information to CCA.

• WTAWaitTimeAnouncement: Demonstrates
how to prompt estimated wait time and queue
position.

EHA This folder contains two sample Error Handling
Applications.

• EHAGeneric: Prompts generic error messages to
a caller.

• EHAOutOFHours: Prompts error message for
calls coming in out of business hours.

3. Open the Eclipse application.

4. In the Eclipse application, click File > Import.

5. Select Existing Project into WorkSpace and click Next.

6. Enable the Select root directory option.

7. Click Browse.

 Note:
Browse to the directory where you have extracted the sample applications.

8. Select the SSA folder.
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9. Click Finish.

10. On the Runtime Version Mismatch window, click OK.

11. Perform the above steps to import all the sample applications that you extracted.

Enabling ICR Pluggable Data Connector plug-in for the SSA
application

Procedure

1. Open the Eclipse application.

2. In the Eclipse SDK application, select the Sample Self Service Application (SSA).

3. Select Project > Properties.

4. On the Properties for SSA window, in the right pane, under Orchestration Designer,
click the Pluggable Connectors tab.

5. From the list of connectors, select ICR Connector.

6. Click OK.

7. Open the main flow of the SSA application.

8. Double-click GetDestinationInformation data node.

 Note:
ICR connector appears in the Palette pane. The Get Destination method of
ICR connector accepts the Skill as an input parameter.

9. Application developer can drag and drop Get Destination method to any data
node in the application as per the business need.

Enabling ICR Pluggable Data Connector plug-in for the SSA application
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Chapter 9: Upgrading ICR Pluggable Data
Connector

ICR Pluggable Data Connector
ICR Pluggable Data Connector (PDC) is a connector between Self Service Application (SSA)
and ICR Core. ICR PDC is built to integrate ICR into Orchestration Designer. ICR PDC is a
generic connector, which an application developer can use without knowledge of call centers
and ICR Core. ICR PDC provides a SIP URI, which is the routing destination for a skill.

ICR PDC also does the load balancing of skill selection requests that arrives across multiple
ICR Cores.

You must upgrade ICR PDC in every SSA to avail enhanced ICR PDC. Once you upgrade ICR
PDC you must deploy SSA on Application Server.

Prerequisite
Orchestration Designer with ICR PDC to create and build applications.

If you are installing Orchestration Designer for the first time, see the Orchestration Designer
documentation from the Avaya support site at http://support.avaya.com.

Upgrading ICR Pluggable Data Connector
Procedure

1. Start the Orchestration Designer Eclipse application.

2. Select the Self Service Application (SSA) project.

3. Select Project > Properties.

4. On the Properties for SSA window, in the left pane select Orchestration Designer
then in the right pane, under Orchestration Designer, click the Pluggable
Connectors tab.

5. From the list of connectors, clear the ICR Connector check box and click OK.

6. Close the Orchestration Designer Eclipse application.
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7. Delete the existing com.avaya.icr.PDC.ui.jar file from <Eclipse_Home>/
plugins folder.

8. Start the Eclipse application.

9. Close the Eclipse application.

10. Copy the com.avaya.icr.PDC.ui.jar file from ICRPDC folder on the CD to
<Eclipse_Home>/plugins folder.

Next steps
You must enable the upgraded ICR PDC for SSA. See Enabling the upgraded ICR Pluggable
Data Connector on page 108.

Enabling ICR Pluggable Data Connector plug-in for the SSA
application

Procedure

1. Open the Eclipse application.

2. In the Eclipse SDK application, select the Sample Self Service Application (SSA).

3. Select Project > Properties.

4. On the Properties for SSA window, in the right pane, under Orchestration Designer,
click the Pluggable Connectors tab.

5. From the list of connectors, select ICR Connector.

6. Click OK.

 Note:
Once you upgrade ICR PDC in SSA, deploy SSA on Application Server. For more
information about deploying SSA, see Application Deployment topic in the
Orchestration Designer Developer guide.
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Chapter 10: Application Server

About application server
Deploy ICR CCA dependent applications, such as SSA, WTAs, and EHAs on an application
server. For information about deploying the dependant application, see the Application
Deployment topic in the Orchestration Designer developer guide.

After you complete deploying the application server, fetch the ICR Core certificates. For more
information, see Importing ICR Core certificate on the application server on page 109.

Importing ICR Core certificate on the application server
Procedure

1. Start the application server.

2. On the application server, open the run-time config application in a browser.
For example: http://localhost:8080/runtimeconfig.

3. Log on to the Orchestration Designer system with administrator privileges.

4. In the left pane, click Certificates.

5. At the bottom of the page, click Fetch.

6. On the Fetch certificate page, enter the values for the following fields in the Fetch
New Certificate area.

• Name: The name of the certificate.

• Location: The IP address or host name of the ICR Core system. For example,
For example: https://<IP_Address_of_the_ICR_Core_system>.

7. Click Continue.

8. Click Save.

9. Restart the application server.
The Application server must be able to communicate with ICR Core server.
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 Note:
Add the IP address and the host names of the ICR Core system in the /etc/
hosts file of the application server.

Application Server
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Chapter 11: Configuring ICR properties

ICR Core property file description 
The following table provides information about the ICR Core properties in the
icrcore.properties file. The icrcore.properties file is present in the
$AVAYA_ICCORE_HOME/tomcat/conf directory.

Property name Description Default value Possible value
ICRAdminURL The IP address of the

Experience Portal
Manager system where
the ICR Admin
component is deployed.
ICR Core uses the
ICRAdminURL property
to obtain the ICR
configuration.

The IP address of
the primary
Experience Portal
Manager system
that you entered
when installing
ICR Core.

The IP address of
the primary
Experience Portal
Manager system.

VPRemoteLogWebSe
rvice

The Web service URL
that ICR Core uses to
post error logs to primary
Experience Portal
Manager system.

https://
%Primary_EP
M_IP_ADDRES
S%/axis/
services/
LogServer-1
.0

Not applicable.

VPProductID The Product ID of Avaya
Aura® Experience
Portal.
This property is required
for pushing log
messages from ICR
Core to Experience
Portal Manager.

The product ID of
the primary
Experience Portal
Manager system
that you entered
when installing
ICR Core.

The product ID of
the primary
Experience Portal
Manager system.

VPRetryAfter The delay in
milliseconds, after which
ICR Core retries sending
logs to Experience
Portal Manager, if the

30000 Not applicable.
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Property name Description Default value Possible value
earlier execution fails to
send the logs.

AGENT_SURPLUS_
FRESHNESS_ENAB
LED

Enabling this property
reduces the cache
freshness interval for all
skills under the agent
surplus situation. ICR
identifies the agent
surplus situation when
Communication
Manager returns EWT
as 0 to ICR when ICR
Core is polling for BSR.
If you set the value of the
property to true, ICR
Core uses the value of
AGENT_SURPLUS_FR
ESHNESS_INTERVAL
property as the cache
freshness interval.
If you set the value of
this property to false,
ICR Core uses the
cache freshness and
slack time value
configured on the Skills
web page in the
Experience Portal
Manager system.

false • true

• false

AGENT_SURPLUS_
FRESHNESS_INTER
VAL

Use this property to
define the interval for
cache freshness under
agent surplus situation.

 Note:
Setting a low interval
value to this property
might affect the
performance of
Communication
Manager because
based on the value of
this property, ICR
frequently polls
Communication
Manager for BSR.
Therefore, you must

10
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Property name Description Default value Possible value
check the traffic to
Communication
Manager and
accordingly set a
proper value to this
property.

Optional properties

ICRSipDebug Enables SIP debug
messages to be printed
in the
AvayaICRDebug.lo
g file. The
AvayaICRDebug.lo
g file is located in the
$AVAYA_ICRCORE_H
OME/tomcat/log
directory.

OFF • OFF

• DEBUG

ICRKeystore The ICR Core certificate
storage location.

$AVAYA_ICRC
ORE_HOME/
tomcat/
conf/
keystore

Not applicable.

ICRKeyStorePasswor
d

The ICR Core certificate
storage password.

changeit Not applicable.

ICRTrustStore The certificate storage
location.

$AVAYA_ICRC
ORE_HOME/
tomcat/
conf/
truststore

Not applicable.

ICRTrustStorePassw
ord

The certificate storage
password.

changeit Not applicable.

ICRSipUserName A Sip account
configured on System
Manager.

avaya Enter the SIP user
name configured on
System Manager if
the user name is
other than avaya.

ICRSipPassword A Sip account password
configured on System
Manager.

avaya123 Enter the password
configured on
System Manager for
SIP user.

ICR Core property file description
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Property name Description Default value Possible value
ICRBsrRequestTimeo
ut

The time in milliseconds
to wait for all responses
of polling request that
ICR Core sends.

8000 Change depending
upon network
delay.

ICRCacheUpdateTim
eout

The time in milliseconds
to wait for cache
update.

1000
 Note:

No change is
required.

ICRSchedulerDelay The time in milliseconds
to check availability of
ACD or Proxy. The value
specifies the delay after
which BSR skill module
starts the status check
for Communication
Manager and Avaya
Aura® Session Manager
that are out of service.

60000 Not applicable.

ICRSipTCPPort A TCP port that ICR
Core uses for SIP
communication with
proxy.

5060 TCP port for SIP
communication with
proxy server.

ICRSipTLSPort A TLS port that ICR Core
uses for SIP
communication with
proxy.

5061 TLS port for SIP
communication with
proxy server.

ICRLogThrottlingTime
out

The time in milliseconds
to suppress subsequent
logs.

60000 Not applicable.

ICRDNSPollingTime The time interval in
seconds after which ICR
Core queries the DNS
server for SIP proxy
servers if you configured
the SIP connection as
DNS SRV domain.

3600 Not applicable.

ICRACDSchedulerEn
abled

The value that indicates
whether ICR Core
monitors the status of
ACD or not.

 Note:
If you configured
multiple IP addresses

false • false

• true
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Property name Description Default value Possible value
of ACD, such as
Enterprise Survivable
Server (ESS) or
CLAN, on Avaya
Aura® Session
Manager using the
Local Host Name
Resolution option,
you must set the
ICRACDSchedulerE
nabled parameter to
false.

ICRSocketConnectio
nTimeout

The time in milliseconds
for which ICR Core waits
for socket connection
with the proxy server.
On failing to establish a
socket connection, ICR
Core considers the next
available proxy server, if
configured.

5000
 Note:

No change is
required.

ADJUST_WAT_VAL
UE

ICR Core uses
ADJUST_WAT_VALUE
if ICR Core receives
WAT = 0 from
Communication
Manager during polling.
ADJUST_WAT_VALUE
is used in the adjustment
of EWT.

1 Not applicable.

 Note:
After making the changes in the icrcore.properties file, you must restart ICR Core for
the changes to take effect. To restart ICR Core, run the service icrcore restart
command.

ICR CCA property file description 
The following table provides information about the ICR CCA properties provided in the
icrcca.properties file. The icrcca.properties file is present in the
$AVAYA_ICRCCA_HOME/tomcat/conf directory.

ICR CCA property file description
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Property name Description Default
value

Possible value

ICRAppConfigWSURL An ICR Admin URL is used
to obtain the ICR
configuration.

https:
// %ICR
Admin_
IP_ADD
RESS%/
VP_ICR
Admin/
servic
es/
appcon
figrea
der

Not applicable.

debug Enables ICR CCA to log the
<log> elements in the
CCXML-SessionSlot-
XXX.log file.

 Important:
When you set the debug
property to true, Media
Processing Platform
(MPP) creates
Application Detail
Records (ADR) on MPP.
As a result, the disk
space utilization
increases and the
performance of ICR
degrades. Therefore,
set this property to true
only for testing purpose.

false. • true

• false

scheduleInterval The time in seconds after
which CCA checks
modification of ICR CCA
application configuration.

120 Enter value in
seconds as per
customer
requirement.

prov_timeout The time in seconds for
which CCA waits for the
182 Queued response for a
no media call.

90s
 Note:

Specify the
property value
followed by s, for
seconds.

ewtUpdatePercent If the percentage difference
between two successive
EWT values is greater than

20 Not applicable.
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Property name Description Default
value

Possible value

ewtUpdatePercent value,
ICR CCA stops and starts
the same WTA.
ewtUpdatePercent value is
used in conjunction with
ewtUpdateDiff property.

ewtUpdateDiff If the difference between
two successive EWT
values is greater than the
configured ewtUpdateDiff
value then, ICR CCA stops
and starts the same WTA.

30 Not applicable.

ewtSpikePercent If the percentage difference
between two successive
EWT values is greater than
the configured
ewtSpikePercent value
then, ICR CCA stops and
starts a new WTA based on
the EWT-WTA mapping.

60 Not applicable.

ewtSpikeDiff If the difference between
two successive EWT
values is greater than the
configured ewtSpikeDiff
value then, ICR CCA stops
and starts a new WTA
based on the EWT-WTA
mapping.

180 Not applicable.

queuePositionUpdateDif
f

If the difference between
two successive
queueposition values is
greater than the configured
queuePositionUpdateDiff
value, ICR CCA stops and
starts the same WTA.

10 Not applicable.

queuePositionSpikeDiff If the difference between
two successive
queueposition values is
greater than the configured
queuePositionSpikeDiff
value, ICR CCA stops and
starts a new WTA based on
the EWT-WTA mapping.

60 Not applicable.
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Property name Description Default
value

Possible value

agenttimeout A blind transfer time-out in
seconds.

120s
 Note:

Specify the
property value
followed by s, for
seconds.

requeuePriority A priority at which calls are
re-queued.

1 The other priorities
are:

• 4 = low

• 3 = medium

• 2 = high

• 1 = top

• 0 = redirect

WebServiceRequestTim
eOut

This property defines time
out for the web service
request made by ICR CCA
during a call re queue to
ICR Core.
If ICR Core does not
respond within the time out
period, ICR CCA moves to
next ICR Core in the
system. The time out is
configured in seconds.

10
 Note:

If the value is set to
the value lesser
than the
ICRBsrRequestT
imeout property
configured in
icrcore.properties
then ICR CCA
might not wait for
ICR Core to
perform polling and
move to next ICR
Core. See ICR
Core property file
description on
page 111.

mergeonconnect The mergeonconnect
property value indicates
merging a call either when
an agent answers the call
or when the call rings at the
agent phone.

• If you set the
mergeonconnect
property to false, ICR
CCA merges the call on
ringing.

false • true

• false
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Property name Description Default
value

Possible value

After setting the
mergeonconnect
property to false, if ICR
CCA receives the answer
event from an agent
phone, ICR CCA merges
the call because the
agent phone configured
in auto answer mode
might not provide the
ringing event.

• If you set the
mergeonconnect
property to true, ICR CCA
merges the call on
answer.
When the
mergeonconnect
property is set to true, the
customer does not hear
the ringing tone and the
call gets connected to the
agent.

defaultProtocolDiscrimin
ator

The default value that ICR
CCA uses for Protocol
Discriminator to construct
UUI.

00 • 00

• 04

readProtocolDiscriminat
orFromIncomingCall

This property enables ICR
CCA to read the protocol
discriminator from the
incoming call in the Shared
UUI mode.
If you set the value of this
property to true, ICR CCA
uses the protocol
discriminator value from
incoming call to construct
UUI.
If you set the value of this
property to false, ICR CCA
uses the default Protocol
Discriminator to construct
UUI.

false • true

• false
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 Note:
After making changes in the icrcca.properties file, you must restart ICR CCA for the
changes to take effect. To restart the ICR CCA, run the service icrcca restart
command.

ICR Admin property file description 
This table provides information about the ICR Admin properties available in the
VP_ICRAdmin.properties file. The VP_ICRAdmin.properties file is present in the
$CATALINA_HOME/lib/extensions/ICR/config/ directory.

Property name Description Default value Possible value
securityTrustStore The ICR Admin

truststore file
location.
SecurityTrustStore
file stores the ICR
Admin certificate.

/opt/Tomcat/tomcat/
conf/truststore

Not applicable.

securityTrustStoreP
wd

The password for the
truststore file.

changeit Not applicable.

securityKeyStore The ICR Admin
Keystore file location.
ICR Admin Keystore
file stores the ICR
admin certificate.

/opt/Tomcat/tomcat/
conf/keystore

Not applicable.

securityKeyStorePw
d

The password for the
Keystore file.

changeit Not applicable.

HeartbeatInterval The time in seconds
after which ICR
Admin obtains the
current state of ICR
Core.

30 Not applicable.

HeartbeatRetries A heartbeat retry
count after which ICR
Admin marks the ICR
Core as OFFLINE.

3 Not applicable.

NodeDelimiter The property that
separates the call
records while storing
the call record in the
in-memory
database.

The property shows
the HTML encode
value for # which is
%23

 Note:
No change required.
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Property name Description Default value Possible value
AttributeDelimiter The property that

separats different
attributes of call
records.

The property shows
the HTML encode
value for comma (',')
which is %2C

 Note:
No change required.

QueuedCallConsolid
atorSeq

A Queued call data
sequence received
from MPP.

sessionid,ucid,skillid
,callcentername,dest
ination,qpos,ewt,calli
ngno,mppName

 Note:
No change required.

AppCallConsolidator
Seq

An Application call
data sequence
received from MPP.

sessionid,ucid,appn
ame,apptype,ssaapp
name,wtaappname
,ehaappname,called
no,callingno

 Note:
No change required.

QueuedCallURLFor
mat

A URL that ICR
Admin uses to obtain
Queued call
information from
MPP.

/mpp/sconfig/
fetchCallDetail.php?
fetchType=queuedc
all

 Note:
No change required.

AppCallURLFormat A URL that ICR
Admin uses to obtain
Application call
information from
MPP.

/mpp/sconfig/
fetchCallDetail.php?
fetchType=appcall

 Note:
No change required.

SummaryCallURLFo
rmat

A URL that ICR
Admin uses to obtain
Queued call and
Application call
summary information
from MPP.

/mpp/sconfig/
fetchCallDetail.php?
fetchType=summary
call

 Note:
No change required.

CreateDBFURLFor
mat

A URL to create
database on MPP for
collecting data feeds
of queued and
application calls.

/mpp/sconfig/
createCallDetails.ph
p

 Note:
No change required.

ReportPollingInterval Polling time in
milliseconds at which
ICR Admin obtains
call details from
every MPP.

30000 Not applicable.

ReportingConnRead
TimeOutInterval

The time for which
ICR Admin waits for
MPP to fetch call
details.

1000 Not applicable.
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Property name Description Default value Possible value
ReportPollingWaitTi
me

The time in
milliseconds for
which ICR Admin
waits for the
response from ICR
Report Manager to
consolidate real time
data from all MPP's.

2500 Not applicable.

ReportCacheClearIn
terval

The time in minutes
after which ICR
Admin clears the in-
memory cached
data.

10 Not applicable.

ICRContextRoot A URL that ICR
Admin uses for
polling the remote
Experience Portal
Manager system for
real time data.

/VP_ICRAdmin/
 Note:

No change required.

RemoteVpPollingDu
ration

The time in
milliseconds for
which every Remote
Experience Portal
Manager system is
polled for real time
data.
RemoteVpPollingDu
ration timer starts as
soon as you access
the ICR monitor
page.

600000 Not applicable.

RemoteVPReportPa
th

A URL that invokes
remote Experience
Portal Manager
systems for updating
real time data of
Experience Portal
Manager system in
common reporting
database.

report/
 Note:

No change required.

ICRAdminThrottling
TimeOut

The time in minutes
after which ICR
Admin suppresses
the same
subsequent ICR
reporting logs being

10 Not applicable.
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Property name Description Default value Possible value
sent to Experience
Portal Manager.

EnableRealTimeRa
wDataLog

A value that enables
or disables ICR
reporting log
throttling.

False
 Note:

No change required.

RemoteDBQueryTim
eOut

Time in seconds for
which ICR Admin
waits for updating
and obtaining real
time data from the
reporting database.

10 Not applicable.

sipInfoSeparator The property used in
EPMSIP table, which
stores SIP
connection
information.

|
 Note:

No change required.

CleanMPPURLForm
at

A URL used to clean
up call records that
does not exist on the
MPP database.
When queued or
application call
records are not
removed from MPP
data,
CleanMPPURLForm
at sends a delete
request to MPP to
clean the records
based on the
configured SAA,
WTA, and EHA
parameter values.
The parameter value
is in minutes.

/mpp/sconfig/
deleteOldCallDetails
.php?
ssa=360&wta=15&e
ha=15
In the URL:

• The ssa=360
parameter
indicates the ICR
Admin cleans the
Call records of SSA
which does not
exist on MPP after
360 minutes.

• The wta=15
parameter
indicates the ICR
Admin cleans the
Call records of
WTA which does
not exist on MPP
after 15 minutes.

• The eha=15
parameter
indicates the ICR
Admin cleans the
Call records of
EHA which does

Not applicable.
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Property name Description Default value Possible value

not exist on MPP
after 15 minutes.

CleanMPPStaleData
Interval

The time interval in
minutes after which
ICR Admin runs the
scheduler for
cleaning the call
records from the
database and the
data in the memory,
which does not exist
on MPP.

15 Not applicable.

 Note:
After making changes in the VP_ICRAdmin.properties file, you must restart the
Experience Portal Manager service.

ICR PDC property file description
The icrpdc.properties file is present in the WEB-INF/lib directory of Self Service
Application (SSA) in Avaya Aura® Orchestration Designer. After making changes to
icrpdc.properties, you must deploy SSA on Application Server.

 Note:
The icrpdc.properties file is present in WEB-INF/lib directory of Self Service
Application (SSA) on Application Server after the deployment. If you change
icrpdc.properties on Application Server, you must restart SSA.

The following table provides information about the ICR PDC properties file.

Property name Description Default value Possible value
WebServiceReques
tTimeOut

This property defines
time out for the web
service request made
by ICR PDC to
randomly selected
ICR Core.
If ICR Core does not
respond within the
time out period, ICR
PDC moves to next
ICR Core in the

10
 Note:

If the value is set to
the value lesser
than the
ICRBsrRequestT
imeout property
configured in
icrcore.properties
then ICR CCA might
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Property name Description Default value Possible value
system. The time out
is configured in
seconds.

not wait for ICR
Core to perform
polling and move to
next ICR Core. See 
ICR Core property
file description on
page 111.
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Chapter 12: Uninstalling Intelligent
Customer Routing

Uninstalling ICR components

Uninstalling ICR Admin
Procedure

1. Log on to the Linux system either locally as a root user or remotely as a non-root
user and change the user to root by using the su - command.

2. If you are an Avaya Services representative and if you are using Avaya Enterprise
Linux or if the Avaya Service accounts are installed on this Core system:

• Log on to the local Linux system as a sroot user.

• Or log on remotely as a non-root user and change the user to sroot by entering
the su - sroot command.

3. Type cd $AVAYA_ICRADMIN_HOME/../ICR_Uninstaller to change the
directory and press Enter.

4. Type ./Uninstall_ICR -i console and press Enter to start the uninstaller
in the console mode.

 Note:
If you installed ICR using the silent mode, the uninstaller silently uninstalls all the
installed ICR components when you invoke the uninstaller by using the
command ./Uninstall_ICR . However, if you run the uninstaller in the console
mode using the command ./Uninstall_ICR -i console, the silent
uninstallation displays the uninstallation screens.

5. On the Uninstall ICR screen, press Enter.
========================================================================
Uninstall ICR
-------------

About to uninstall...
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ICR

This will remove features installed by InstallAnywhere.  It will not 
remove files and folders created after the installation.

PRESS <ENTER> TO CONTINUE:
=========================================================================

6. On the Uninstall Options screen, type 2 to choose specific features to uninstall
or type 1 to continue uninstalling all the ICR features and components and press
Enter.
=========================================================================
Uninstall Options
-----------------

ENTER THE NUMBER FOR YOUR CHOICE, OR PRESS <ENTER> TO ACCEPT THE DEFAULT:

  ->1- Completely remove all features and components.
    2- Choose specific features that were installed by InstallAnywhere.

Please choose one of the following options:: 
=========================================================================

7. On the Choose Product Features screen, type the corresponding number to
the feature to uninstall ICR Admin and press Enter.
===================================================================
Choose Product Features
-----------------------

ENTER A COMMA_SEPARATED LIST OF NUMBERS REPRESENTING THE FEATURES YOU 
WOULD LIKE TO SELECT, OR DESELECT.

TO VIEW A FEATURE'S DESCRIPTION, ENTER '?<Number>'  PRESS <Enter> WHEN YOU 
ARE DONE:

    1- [ ] ICRAdmin

Check the features that you want to uninstall. Unchecked features will 
remain installed.: 
====================================================================

8. On the Uninstall Confirmation screen, type 1 to confirm the unistallation or
type 2 to cancel the uninstallation process and press Enter.
===================================================================
Are you sure you want to uninstall feature(s) ICRAdmin?
-------------------------------------------------------

This will uninstall feature(s) ICRAdmin. Select "OK" to continue or 
"Cancel" to exit.

  ->1- OK
    2- Cancel

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
====================================================================
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The installer displays the Stopping services for ICRAdmin screen to
confirm about stopping the ICR Admin service. Press Enter to continue
uninstallation.
===================================================================
Stopping services for ICRAdmin
------------------------------
Uninstaller will stop running services of respective components before 
uninstalling.

PRESS <ENTER> TO CONTINUE:
====================================================================

Wait for the unistallation procedure to complete.

 Note:
The uninstaller stops the vpms services for the ICR Admin and removes the
selected components installed by the installer. The vpms services are started
once the uninstallation is completed. However, the uninstaller does not remove
the files and folders created after the installation. You must manually delete the
component directories from the installed location after uninstalling ICR
component.

9. Log out from the Linux session and open a new Linux session to reinstall ICR.
The updated environment variables are available in a new session.

Uninstalling ICR CCA
Procedure

1. Log on to the Linux system either locally as a root user or remotely as a non-root
user and change the user to root by using the su - command.

2. If you are an Avaya Services representative and if you are using Avaya Enterprise
Linux or if the Avaya Service accounts are installed on this Core system:

• Log on to the local Linux system as a sroot user.
• Or log on remotely as a non-root user and change the user to sroot by entering

the su - sroot command.

3. On the screen, type cd $AVAYA_ICRCCA_HOME/../ICR_Uninstaller and
press Enter.

4. Type ./Uninstall_ICR -i console and press Enter to start the unistaller
console mode.

 Note:
If you installed ICR using the silent mode, the uninstaller silently uninstalls all the
installed ICR components when you invoke the uninstaller by using the
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command ./Uninstall_ICR . However, if you run the uninstaller in the console
mode using the command ./Uninstall_ICR -i console, the silent
uninstallation displays the uninstallation screens.

5. On the Uninstall ICR screen, press Enter.
=========================================================================
=
Uninstall ICR
-------------

About to uninstall...

ICR

This will remove features installed by InstallAnywhere.  It will not 
remove files and folders created after the installation.
PRESS <ENTER> TO CONTINUE:
=========================================================================
=

6. On the Uninstall Options screen, type 2 to choose specific features to uninstall
or type 1 to continue uninstalling all the ICR features and components and press
Enter.
=========================================================================
=
Uninstall Options
-----------------

ENTER THE NUMBER FOR YOUR CHOICE, OR PRESS <ENTER> TO ACCEPT THE DEFAULT:

  ->1- Completely remove all features and components.
    2- Choose specific features that were installed by InstallAnywhere.

Please choose one of the following options:: 
=========================================================================
=

7. On the Choose Product Features screen, type the corresponding number to
the feature to uninstall ICR CCA and press Enter.
=========================================================================
==
Choose Product Features
-----------------------

ENTER A COMMA_SEPARATED LIST OF NUMBERS REPRESENTING THE FEATURES YOU 
WOULD LIKE TO SELECT, OR DESELECT.

TO VIEW A FEATURE'S DESCRIPTION, ENTER '?<Number>'  PRESS <Enter> WHEN YOU 
ARE DONE:

    1- [ ] ICRACCA

Check the features that you want to uninstall. Unchecked features will 
remain installed.: 
=========================================================================
===

8. On the Uninstall Confirmation screen, type 1 to confirm the unistallation or
type 2 to cancel the uninstallation process and press Enter.
=========================================================================
===
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Are you sure you want to uninstall feature(s) ICRCCA
?
-------------------------------------------------------

This will uninstall feature(s) ICRCCA. Select "OK" to continue or "Cancel" 
to exit.

  ->1- OK
    2- Cancel

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
=========================================================================
====

The installer displays the Stopping services for ICRCCA screen to confirm
about stopping the ICR CCA service. Press Enter to continue uninstallation.

=========================================================================
====
Stopping services for ICRCCA
------------------------------
Uninstaller will stop running services of respective components before 
uninstalling.

PRESS <ENTER> TO CONTINUE:
=========================================================================
====

Wait for the unistallation procedure to complete.

 Note:
The uninstaller stops the vpms services for the ICR Admin and removes the
selected components installed by the installer. The vpms services are started
once the uninstallation is completed. However, the uninstaller does not remove
the files and folders created after the installation. You must manually delete the
component directories from the installed location after uninstalling ICR
component.

9. Log out from the Linux session and open a new Linux session to reinstall ICR.
The updated environment variables are available in a new session.

Uninstalling ICR Core
Procedure

1. Log on to the Linux system either locally as a root user or remotely as a non-root
user and change the user to root by using the su - command.

2. If you are an Avaya Services representative and if you are using Avaya Enterprise
Linux or if the Avaya Service accounts are installed on this Core system:
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• Log on to the local Linux system as a sroot user.
• Or log on remotely as a non-root user and change the user to sroot by entering

the su - sroot command.

3. On the screen, type cd $AVAYA_ICRCORE_HOME/../ICR_Uninstaller and
press Enter.

4. Type ./Uninstall_ICR -i console and press Enter to start the uninstaller
in the console mode.

 Note:
If you installed ICR using the silent mode, the uninstaller silently uninstalls all the
installed ICR components when you invoke the uninstaller by using the
command ./Uninstall_ICR . However, if you run the uninstaller in the console
mode using the command ./Uninstall_ICR -i console, the silent
uninstallation displays the uninstallation screens.

5. On the Uninstall ICR screen, press Enter.
=====================================================================
Uninstall ICR
-------------

About to uninstall...

ICR

This will remove features installed by InstallAnywhere.  It will not 
remove files and folders created after the installation.

PRESS <ENTER> TO CONTINUE:
====================================================================

6. On the Uninstall Options screen, type 1 to continue uninstalling all the ICR
features and components or type 2 to choose specific features to uninstall and press
Enter.
====================================================================
Uninstall Options
-----------------

ENTER THE NUMBER FOR YOUR CHOICE, OR PRESS <ENTER> TO ACCEPT THE DEFAULT:

  ->1- Completely remove all features and components.
    2- Choose specific features that were installed by InstallAnywhere.

Please choose one of the following options:: 
===================================================================

7. On the Choose Product Features screen, type the corresponding number to
the feature to uninstall ICR Core and press Enter.
===================================================================
Choose Product Features
-----------------------

ENTER A COMMA_SEPARATED LIST OF NUMBERS REPRESENTING THE FEATURES YOU 
WOULD LIKE TO SELECT, OR DESELECT.

TO VIEW A FEATURE'S DESCRIPTION, ENTER '?<Number>'  PRESS <Enter> WHEN YOU 

Uninstalling Intelligent Customer Routing

132     Implementing Intelligent Customer Routing (ICR) May 2014
Comments? infodev@avaya.com

mailto:infodev@avaya.com?subject=Implementing Intelligent Customer Routing (ICR)


ARE DONE:

    1- [ ] ICRCore

Check the features that you want to uninstall. Unchecked features will 
remain installed.: 
=====================================================================

8. On the Uninstall Confirmation screen, type 1 to confirm the unistallation or
type 2 to cancel the uninstallation process and press Enter.
======================================================================
Are you sure you want to uninstall feature(s) ICRCore?
-------------------------------------------------------

This will uninstall feature(s) ICRCore. Select "OK" to continue or 
"Cancel" to exit.

  ->1- OK
    2- Cancel

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
======================================================================

The installer displays the Stopping services for ICRCore screen to confirm
about stopping the ICR Core service. Press Enter to continue uninstallation.

====================================================================
Stopping services for ICRCore
------------------------------
Uninstaller will stop running services of respective components before 
uninstalling.

PRESS <ENTER> TO CONTINUE:
====================================================================

Wait for the unistallation procedure to complete.

 Note:
The uninstaller stops the vpms services for the ICR Admin and removes the
selected components installed by the installer. The vpms services are started
once the uninstallation is completed. However, the uninstaller does not remove
the files and folders created after the installation. You must manually delete the
component directories from the installed location after uninstalling ICR
component.

9. Log out from the Linux session and open a new Linux session to reinstall ICR.
The updated environment variables are available in a new session.
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Uninstalling ICR components installed on a standalone
system

Procedure

1. Log on to the Linux system either locally as a root user or remotely as a non-root
user and change the user to root by using the su - command.

2. If you are an Avaya Services representative and if you are using Avaya Enterprise
Linux or if the Avaya Service accounts are installed on this Core system:

• Log on to the local Linux system as a sroot user.
• Or log on remotely as a non-root user and change the user to sroot by entering

the su - sroot command.

3. Type cd $AVAYA_ICRADMIN_HOME/../ICR_Uninstaller to change the
directory and press Enter.

4. Type ./Uninstall_ICR -i console and press Enter to start the uninstaller
in the console mode.

 Note:
If you installed ICR using the silent mode, the uninstaller silently uninstalls all the
installed ICR components when you invoke the uninstaller by using the
command ./Uninstall_ICR . However, if you run the uninstaller in the console
mode using the command ./Uninstall_ICR -i console, the silent
uninstallation displays the uninstallation screens.

5. On the Uninstall ICR screen, press Enter.
===================================================================
Uninstall ICR
-------------

About to uninstall...

ICR

This will remove features installed by InstallAnywhere.  It will not 
remove files and folders created after the installation.

PRESS <ENTER> TO CONTINUE:
====================================================================

6. On the Uninstall Options screen, type 1 to continue uninstalling all the ICR
features and components or type 2 to choose specific features to uninstall and press
Enter.
====================================================================
Uninstall Options
-----------------
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ENTER THE NUMBER FOR YOUR CHOICE, OR PRESS <ENTER> TO ACCEPT THE DEFAULT:

  ->1- Completely remove all features and components.
    2- Choose specific features that were installed by InstallAnywhere.

Please choose one of the following options:: 2
===================================================================

7. On the Choose Product Feature screen, type the number corresponding to the
feature that you want to uninstall and press Enter.
For multiple features, type the numbers separating with a comma.
=====================================================================
Choose Product Features
-----------------------

ENTER A COMMA_SEPARATED LIST OF NUMBERS REPRESENTING THE FEATURES YOU 
WOULD LIKE TO SELECT, OR DESELECT. 

TO VIEW A FEATURE'S DESCRIPTION, ENTER '?<NUMBER>'. PRESS <ENTER> WHEN YOU 
ARE DONE:

    1- [ ] ICRAdmin
    2- [ ] ICRCCA
    3- [ ] ICRCore

Check the features that you want to uninstall. Unchecked features will 
remain installed.:
======================================================================

 Note:
If you do not see all the ICR features and components on the Choose Product
Features screen, you must separately uninstall the ICR components.

For more information about uninstalling individual ICR components , see 
Uninstalling ICR Admin on page 127, Uninstalling ICR CCA on page 129, 
Uninstalling ICR Core on page 131.

8. On the Uninstall Confirmation screen, type 1 to confirm the unistallation or
type 2 to cancel the uninstallation process and press Enter.
===================================================================
Are you sure you want to uninstall feature(s) ICRAdmin,ICRCCA,ICRCore?
?
-----------------------------------------------------

This will uninstall feature(s) ICRAdmin,ICRCCA,ICRCore. Select "OK" to 
continue or "Cancel" to exit.

  ->1- OK
    2- Cancel

ENTER THE NUMBER OF THE DESIRED CHOICE, OR PRESS <ENTER> TO ACCEPT THE 
DEFAULT:
====================================================================

Uninstalling ICR components installed on a standalone system

Implementing Intelligent Customer Routing (ICR) May 2014     135



The installer displays the Stopping services screen to confirm about stopping
the ICR components services for the selected ICR components for uninstallation.
Press Enter to continue uninstallation.

=====================================================================
Stopping services for ICRAdmin,ICRCCA,ICRCore

------------------------------
Uninstaller will stop running services of respective components before 
uninstalling.

PRESS <ENTER> TO CONTINUE:
====================================================================

Wait for the unistallation procedure to complete.

 Note:
The uninstaller stops the vpms services for the ICR Admin and removes the
selected components installed by the installer. The vpms services are started
once the uninstallation is completed. However, the uninstaller does not remove
the files and folders created after the installation. You must manually delete the
component directories from the installed location after uninstalling ICR
component.

9. Log out from the Linux session and open a new Linux session to reinstall ICR.
The updated environment variables are available in a new session.

Uninstalling ICR in silent mode
About this task

 Note:
If you installed ICR using the silent mode, the uninstaller silently uninstalls all the installed
ICR components when you invoke the uninstaller by using the command ./
Uninstall_ICR . However, if you run the uninstaller in the console mode using the
command ./Uninstall_ICR -i console , the silent uninstallation displays the
uninstallation screens.

Procedure

1. Log on to the Linux system either locally as a root user or remotely as a non-root
user and change the user to root by using the su - command.

2. If you are an Avaya Services representative and if you are using Avaya Enterprise
Linux or if the Avaya Service accounts are installed on this Core system:

• Log on to the local Linux system as a sroot user.
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• Or log on remotely as a non-root user and change the user to sroot by entering
the su - sroot command.

3. Type cd $AVAYA_ICRADMIN_HOME/../ICR_Uninstaller and press Enter.

4. Type ./Uninstall_ICR to uninstall all the ICR components silently.

5. Log out from the Linux session and open a new Linux session to reinstall ICR.
The updated environment variables are available in a new session.

Uninstalling ICR in silent mode
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Appendix A: ICR CCA properties
configuration for EWT or queue
position update and spike

ICR CCA recognizes the Estimated Wait Time (EWT) update and spike based on the increase in the EWT
or queue position received from Automatic Call Distribution (ACD).

ICR CCA receives the updated EWT and queue position from ACD after every 60 seconds. ICR CCA
compares the updated EWT and queue position values with the update and spike properties configured
in the icrcca.properties file and determines whether to terminate the running Wait Treatment
Application (WTA) and relaunch the same WTA or launch another WTA.

 Note:

• The spike condition for EWT or queue position occurs only when the update condition for
respective EWT or queue position matches. Therefore, you must keep the EWT update and queue
position update values less than the EWT spike and queue position spike values.

• When both the update and spike conditions for EWT or queue position matches, ICR considers
the increase in EWT or queue position as spike.

In ICR, configure the following properties for ICR CCA to determine the EWT or queue position update
and spike. You can find the properties in the icrcca.properties file located in the
$AVAYA_ICRCCA_HOME/tomcat/conf directory.

EWT update
ICR CCA determines the EWT update based on the difference between two successive EWT values and
percentage difference between two successive EWT values.

• ewtUpdatePercent: If the percentage difference between two successive EWT values is greater
than the value set in the ewtUpdatePercent property, ICR CCA stops the running WTA and
relaunches the same WTA. ICR CCA uses the ewtUpdatePercent property in conjunction with
ewtUpdateDiff property.

For example: The ewtUpdatePercent property is set to 20. For a call in queue, the first EWT that
ICR CCA receives from ACD is 100 and for the same call, the second EWT that ICR CCA receives
from ACD is 150.

As per the above example, the percentage difference between two EWT values is 50%, which is
greater than the value 20 set in the ewtUpdateDiff property. Therefore, ICR CCA stops the running
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WTA and relaunch the same WTA if the increase in EWT also meets the ewtUpdateDiff property
configuration as mentioned below.

• ewtUpdateDiff: If the difference between two successive EWT values is greater than the value set
in the ewtUpdateDiff property, ICR CCA stops the running WTA and relaunches the same WTA.
ICR CCA uses the ewtUpdateDiff property in conjunction with ewtUpdatePercent property.

For Example: The ewtUpdatePercent property is set to 20 and the ewtUpdateDiff property is
set to 30. For a call in queue, the first EWT that ICR CCA receives from ACD is 100 and for the same
call, the second EWT that ICR CCA receives is 150.

As per the above example, the difference between second EWT value and first EWT value is 50,
which is greater than the value set in the ewtUpdateDiff property and percentage difference
between first and second EWT value is 50%, which is also greater than the value set in the
ewtUpdatePercent property. Therefore ICR CCA will terminate the running WTA and relaunch
the same WTA.

EWT spike
ICR CCA determines the EWT spike based on the difference between two successive EWT values and
percentage difference between two successive EWT values.

• ewtSpikePercent: If the percentage difference between two successive EWT values is greater than
the value set in the ewtSpikePercent property, ICR CCA stops the running WTA. After that ICR
CCA launches a new WTA configured in EWT range mapping for Skill-WTA or relaunches the
same WTA. ICR CCA uses the ewtSpikePercent property in conjunction with the ewtSpikeDiff
property.

Examples:

- The ewtSpikePercent property is set to 1000. For a call in queue, the first EWT that ICR
CCA receives from ACD is 120 and for the same call, the second EWT that ICR CCA receives
is 300.

As per the above example, there is 250% increase in EWT, which is less than the value set in
the ewtSpikePercent property. Therefore, ICR CCA does not consider the increase in EWT
as spike.

- The ewtSpikePercent property is set to 1000. For a call in queue, the first EWT that ICR
CCA receives from ACD is 120 and for the same call, the second EWT that ICR CCA receives
is 1800.

As per the above example, there is 1500% increase in EWT, which is greater than 1000.
Therefore, ICR CCA considers the increase in EWT as spike and stops the running WTA if the
increase in EWT also meets the ewtSpikeDiff property configuration as mentioned below.
After that ICR CCA launches a new WTA based on the EWT range that you specify in EWT
range mapping for Skill-WTA or relaunches the same WTA.

• ewtSpikeDiff: If the difference between two successive EWT values is greater than the value set in
the ewtSpikeDiff property, ICR CCA stops the running WTA and launches a new WTA based on
the EWT range that you specify in EWT range mapping for Skill-WTA or relaunches the same
WTA. ICR CCA uses the ewtSpikeDiff property in conjunction with the ewtSpikePercent
property.
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Examples:

- The ewtSpikePercent property is set to 1000 and the ewtSpikeDiff property is set to 100.
For a call in queue, the first EWT that ICR CCA receives from ACD is 5 and for the same call,
the second EWT that ICR CCA receives is 80.

As per the above example, there is 1600% increase in the new EWT value but the spike
difference is 75, which is less than the value set in the ewtSpikeDiff property. Therefore,
ICR CCA does not consider the increase in EWT as spike.

- The ewtSpikePercent property is set to 1000 and the ewtSpikeDiff property is set to 100.
For a call in queue, the first EWT that ICR CCA receives from ACD is 30 and for the same call,
the second EWT that ICR CCA receives is 400.

As per the above example, there is 1333% increase in the new EWT value and spike difference
is 370, which is greater than the value set in the ewtSpikeDiff property. Therefore, ICR CCA
considers the increase in EWT as a spike. After that ICR CCA stops the running WTA and
launches a new WTA configured in EWT range mapping for Skill-WTA or relaunches the same
WTA.

Queue position update
Similar to EWT update, ICR CCA determines the queue position update using the following property.

• queuePositionUpdateDiff: If the difference between two successive queue position values is greater
than the value set in the queuePositionUpdateDiff property, ICR CCA stops the running WTA and
relaunches the same WTA.

For Example: The queuePositionUpdateDiff property is set to 10. For a call in queue, the current
queue position that ICR CCA receives from ACD is 50 and for the same call, the new queue position
that ICR CCA receives from ACD is 80.

As per the above example, the difference in two queue position values is 30, which is greater than the
value set in the queuePositionUpdateDiff property. Therefore, ICR CCA stops the running WTA
and relaunches the same WTA.

Queue position spike
Similar to EWT spike, ICR CCA determines the queue position spike using the following property.

• queuePositionSpikeDiff: If the difference between two successive queue position values is greater
than the value set in the queuePositionSpikeDiff property, ICR CCA stops the running WTA and
launches a new WTA based on the EWT range that you specify in EWT range mapping for Skill-
WTA or relaunches the same WTA.

For example: The queuePositionSpikeDiff property is set to 60. For a call in queue, the current
queue position that ICR CCA receives from ACD is 50 and for the same call, the new queue position
that ICR CCA receives from ACD is 180.

As per the above example, the difference between two queue position values is 130, which is greater
than the value set in the queuePositionSpikeDiff property. Therefore, ICR CCA stops the running
WTA and launches a new WTA based on the EWT range that you specify in EWT range mapping for
Skill-WTA or relaunches the same WTA.
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Appendix B: Ports used by ICR

ICR Core service

Port Number Protocol Process Used For
9009 TCP Java Apache tomcat AJP

connection.

9005 TCP Java Apache tomcat
shutdown.

5060/5061 TCP Java SIP communication with
a Proxy server.

9090 TCP Java Communication
between ICR Core and
ICR Admin.

ICR Management service

Port Number Protocol Process Used For
9109 TCP Java Apache tomcat AJP

connection.

9005 TCP Java Apache tomcat
shutdown.

Terracotta server

Port Number Protocol Process Used For
9510/9520/9530 TCP Java Communication

between Terracotta
server and ICR Core.

ICR CCA service

Port Number Protocol Process Used For
6009 TCP Java Apache tomcat AJP

connection.

6005 TCP Java Apache tomcat
shutdown.
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Port Number Protocol Process Used For
6080 TCP Java HTTP connection

handler.
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Appendix C: Mounting the ICR media

Before running the ICR installer, you must mount the ICR media from an ISO image format or from a CD
or DVD.

The appendix provides the steps to mount the ICR media both from an ISO image and from a CD or DVD.
However, you can use any one method to mount the ICR media.

Mounting the ISO image of the ICR installer
About this task
If you want to install ICR using the ISO image of an ICR installer, perform the following steps
to mount the ISO image of the ICR installer.

Procedure

1. Download the ISO image of the ICR software from the Avaya support website.

2. Log in to an Experience Portal Manager system on which you want to install ICR.

a. Log on to the Linux system either locally as a root user or remotely as a non-
root user and change the user to root by using the su - command.

b. If you are an Avaya Services representative and if you are using Avaya
Enterprise Linux or if the Avaya Service accounts are installed on this Core
system:

• Log on to the local Linux system as a sroot user.

• Or log on remotely as a non-root user and change the user to sroot by
entering the su - sroot command.

3. Copy the ISO image in a local directory on the system.

4. Create a directory to mount the ISO image.
Enter the command: mkdir <Mount_Point_Directory>.

5. Mount the ISO image.
Enter the command: mount –o loop
<Absolute_Path_Of_ISO_Image_File> <Mount_Point_Directory>.

The system mounts the files from the ISO image of the ICR software installer to the
mount point directory.

6. Change the directory to the mount point directory.
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Enter the command: cd <Mount_Point_Directory>.

Mounting the ICR installer CD or DVD
About this task
If you create an ICR installer CD or DVD using the ISO image, perform the following steps to
mount the ICR installer CD or DVD.

 Note:
If you are unable to mount the installer CD or DVD using the commands given in this topic,
see the server documentation for the appropriate mount command.

Procedure

1. Log in to an Experience Portal Manager system on which you want to install ICR.

a. Log on to the Linux system either locally as a root user or remotely as a non-
root user and change the user to root by using the su - command.

b. If you are an Avaya Services representative and if you are using Avaya
Enterprise Linux or if the Avaya Service accounts are installed on this Core
system:

• Log on to the local Linux system as a sroot user.

• Or log on remotely as a non-root user and change the user to sroot by
entering the su - sroot command.

2. In the CD or DVD drive of the system, insert the ICR software installation CD or
DVD.

 Tip:
The instructions given in this procedure assumes that you access the ICR
installation CD or DVD by mounting the appropriate CD or DVD drive on the target
system. To access the installation CD or DVD files from a shared network
directory or a local directory, copy the files from the ICR installation CD or DVD
to the respective directory. However, all the users on the system must be able to
connect to that directory because the Avaya Aura® Experience Portal installation
script changes users during execution. If the directory is only readable by the root
or sroot user or the directory name contains spaces, the installation script can
encounter errors and cannot complete successfully.

3. Mount the ICR software installation CD or DVD.
The mount command depends on the system hardware and operating system.

Mounting the ICR media
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• If you are working with Avaya Enterprise Linux, enter the command
mount /mnt/cdrom to mount the CD or DVD.

Here, /mnt/cdrom is the mount point usually associated with the CD or DVD device
in the fstab file.

4. If you are working with Red Hat Enterprise Linux Server 6.0, enter the following
commands to mount the CD or DVD:

• mkdir /media/cdrom

 Note:
Run this command only if the /media/cdrom mount point is not created.

• mount /dev/cdrom /media/cdrom

 Warning:
When Red Hat Enterprise Linux Server 6.0 automatically mounts the CD or DVD,
the files on the CD or DVD are not executable. You must manually mount the
ICR software installation CD or DVD using the above commands.

5. Change to the mount point directory.
Enter the command: cd <Mount_Point_Directory>.

Mounting the ICR installer CD or DVD
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